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FLTPLAN ACCOUNT
The FltPlan Go app is a companion to the FltPlan website. If you are not a registered user for FltPlan, please complete the 

following steps prior to using the FltPlan Go app:

REGISTER FLTPLAN.COM ACCOUNT
To create your free account, go to www.FltPlan.com and click the Create Account link at the top of the FltPlan Welcome page. 

Create your username and password on the New Registration page.

	
NOTE: Usernames and passwords must be between 8 and  64 characters, contain one uppercase, one lowercase, and one special 
character. 

	
NOTE: You must complete your username and password and accept the FltPlan disclaimer before you can advance to the registra-
tion form. 

Enter all pertinent information on the registration form in order to file IFR and VFR flight plans. You must enter your name in 
one of the PIC name slots. You can enter up to ten (10) different PIC names and ten (10) different aircraft registration numbers. 
Performance data is supplied for a variety of aircraft types. You can use the generic performance data provided for your aircraft, 
or customize it to match the way you fly. For more information on entering and editing performance data for your aircraft, refer 
to the FltPlan.com User Tutorial.

Once you complete the registration form, you will arrive at the Main Menu page. FltPlan allows you to create and store IFR flight 
plans up to 180 days in advance.

	
NOTE: Flight plans can only be created, stored, and filed if you have entered all of the pertinent info on the Pilot/User Info page 
and have entered at least one aircraft into your account

	
NOTE: FltPlan can be used by anyone to file an IFR or VFR flight plan, but you must be a pilot with a current aviation certificate and 
aviation medical.

REQUEST PERMISSION TO FILE FLIGHT PLANS
The following steps must be completed prior to creating and filing flight plans:

Check the accuracy of your PIC/User Info:

1)	 From the FltPlan.com Main Page, select Main Menu > Settings > User/Pilot Info. 

2)	 Enter First & Last Name, Complete Address, Aircraft Home Base, Phone Number, and Email.

3)	 Check the box that says "I give FltPlan.com authorization to file flight plans on my behalf."

4)	 Once the authorization request is received and processed, FltPlan will send instructions via email regarding account activation.

	
NOTE: FltPlan.com will NOT file your flight plans if the required informatoin is incomplete, or the authorization box is not checked.

	
NOTE: For Corporate email account users, please make sure that all FltPlan email addresses, Info@FltPlan2.com, Info@FltPlan.com, 
and FltPlan.Support@garmin.com, are white listed to ensure these emails are not identified as SPAM.

Watch Help Videos:

1)	 How to Create a Flight Plan.

2)	 Additional videos are available on the Video Support Page. 

http://www.fltplan.com
http://www.fltplan.com
http://www.FltPlan.com
https://www.fltplan.com/tutorial.htm?
https://www.youtube.com/watch?v=rHnal_rkf8U
https://flttrack.fltplan.com/FltPlanVideoSupport/FltPlanVideoSupport.html
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PRE-FLIGHT DEVICE
Make the most of what FltPlan Go has to offer, and download/update the following information from FltPlan before departure:

	4 NavLogs

	4 Charts & Maps

	4 Airport & FBO Information

	4 Trip-related Documents

	4 Create/Edit Checklists

	4 Update/Calculate Weight & Balance Information

FLTPLAN GO SIGN-IN
Now that a FltPlan.com account has been established and verified, the next step is to download the FltPlan Go app from the 

appropriate app store supported by the device being used for flight. With the FltPlan Go app running, sign into your FltPlan.
com account:

Signing Into FltPlan.com on FltPlan Go app:

1)	 Within the FltPlan Go app, select the FltPlan.com icon on the lefthand menu.

2)	 Tap the Sign In button in the top right corner.

3)	 Enter User Name and Password > Sign In.

Or:  If you do not already have a FltPlan.com account, tap the Create Your Account button to register via the instructions listed 
earlier in this document.

PRE-FLIGHT DEVICE
Make the most of what FltPlan Go has to offer, and download/update the following information from FltPlan before departure:

	4 NavLogs

	4 Charts & Maps

	4 Airport & FBO Information

	4 Trip-related Documents

	4 Create/Edit Checklists

	4 Update/Calculate Weight & Balance Information

FLTPLAN GO SIGN-IN
Now that a FltPlan.com account has been established and verified, the next step is to download the FltPlan Go app from the 

appropriate app store supported by the device being used for flight. With the FltPlan Go app running, sign into your FltPlan.
com account:

Signing Into FltPlan.com on FltPlan Go app:

1)	 Within the FltPlan Go app, select the FltPlan.com icon on the lefthand menu.

2)	 Tap the Sign In button in the top right corner.

3)	 Enter User Name and Password > Sign In.

Or:  If you do not already have a FltPlan.com account, tap the Create Your Account button to register via the instructions listed 
earlier in this document.
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FltPlan Go - FltPlan.com Page

Touch to View 
Touch to Add 
Account or Logout
Touch to Create 
Flight Plan 

Touch to Exit App & 
View in Web Browser

Touch to Move 
'Forward' & 'Back' 

Touch to 
Refresh Touch to View 'Home' Page

Touch to 
Hide/View 

Main Menu

Touch to Use 
Stylus/Pen
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HOME MENU
The Home Menu, positioned along the left-hand side of the screen, is the primary means of accessing many of the features of 

FltPlan Go. The Home Menu provides quick access to the various pages within 

HOME MENU ICONS

FltPlan.com Displays FltPlan.com information for flight plans after linking and syncing your FltPlan.com credentials.  

Airports
Displays the Airport Information Page, which includes basic airport info, frequencies, runways, procedures, weather, 
NOTAM's, FBO's, fuel prices/fees, FAA remarks, & Nav Aids. 

Maps Displays the aircraft on a georeferenced map with various overlays and layers of information.

NavLogs
Displays NavLog Options, Split Screen Options, Share/Save Options, Connectivity, My NavLogs/WX, and different 
NavLog format options, e.g. Web or PDF.

External
Displays the External Devices Page, which allows the wireless sharing of data between devices via Bluetooth®, or, 
if properly equipped, Wi-Fi.

Checklist
Displays the Checklist Page where specific aircraft electronic checklists can be viewed to ensure proper flight 
procedures.  

Binders
Displays flight specific binders with customized information related to many items, including documents, 
procedures, airports, NavLogs, and weather.

Weather
Displays the Weather Imagery Page, providing various meteorological data for both real-time and forecast weather 
events.

Tracking Displays the available aircraft ID's the active User set-up for flight tracking.

Tools
Displays two groups of icons, Tools & Calculators. Tools listed include eLogbook, PDC Service, Cloud Tops, Weight 
& Balance, Contacts. Calculators listed include Numeric, Celcius to Fahrenheit, Temperature, Density Altitude, 
Conversions, Equal Time, Winds, and Airport Winds.

Scratch Pad
Displays the Scratch Pad Page, which allows the pilot to quickly draw or write down information on the device 
screen.

Downloads
Displays the Downloads Page, where the User can download and update various charts for offline use. Available 
charts include Maps, Procedures, Documents, A/FD and Miscellaneous. 

Settings

Displays the Settings Page, where the User can adjust how the device interacts with the FltPlan Go program, such 
as Tutorial, Support, Current User, Allow Sleep Mode, Screen Brightness, Super Dim, Allow GPS in Background, 
Minimum Runway Length (ft), Show Notification Alert, Messages From FltPlan, Privacy Policy, App Version, Refresh 
Database, Lock Screen, Clear Cache, Turn Off Map Layers, and Unregister From Notifications. 

Home Menu Icons
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AIRPORTS 
Selecting the Airports icon from the Home Menu will display various details related to the desired airport, which include FBO's, 

Airport Information, Frequencies, Runways, Procedures, Weather, Model Output Statistics (MOS), NOTAMs, Fuel Services/
Information, and  Remarks (Traffic Pattern, After Hours Phone Number(s), etc.).

FltPlan Go - Airports Page - FBOs

Touch to View Info

Touch to View Info 
in Browser via 

FltPlan.com 

Current Selection

Touch to Hide/View 
Main Menu 
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HEADER MENU
The Header Menu is customized for each section (e.g. Airports, Maps, NavLogs, etc.) and contains various buttons to help 

the User navigate the FltPlan Go program quickly. In the Airports section, the available buttons include History, Favorites, View 
on Map, Share and/or Save Airports, Runway Wind Calculator, Airports Near Current Location, Add and/or View Binder(s), 
Airport Diagram, Airports Near Current Selection, and the Airport/Facility Directory (A/FD). 

FltPlan Go - Airports Page - Header Menu

Touch to View 

Touch to Add /
View Binders

Touch to View
Touch to View 
Airports Near 
Current Selection

Touch to View 
Previous Airports

Touch to View on MapTouch to Add/View Favorites Touch to Search Airports
Touch to 

Enter Info
Touch to View Airports 
Near Current Location

Touch to View

HISTORY

Viewing Airport History:

1)	 Touch  within the Airports section to display a menu listing the recent airports searched/used.

2)	 Select the desired airport to view information.

FltPlan Go - Airports Page - History Menu

Touch to Select

Deleting Airport History:

1)	 Touch  within the Airports section to display a menu listing the recent airports searched/used.

2)	 Long press on the desired airport to display a confirmation window asking to remove the airport from History.

3)	 Touch Yes to delete the airport.

	
NOTE: The History drop-down menu holds a maximum of 15 airports. When adding more than 15 airports to the list, the old airport(s) 
will be deleted to allow room for the new airport(s).



FltPlan Go for Android User's Guide190-02961-00 Rev A 9

Airports

FltPlan 
A

ccount
A

irports
M

aps
N

avLogs
External

Checklists
Binders

W
eather

Flight 
Tracking

Tools
Scratch 

Pad
Dow

nloads
Settings

Index

FAVORITES

Viewing Favorite Airports:

1)	 Touch  within the Airports section to display a drop-down menu listing User defined favorites. 

2)	 Select the desired airport.

Adding Favorite Airport:

1)	 Touch  within the Airports section to display a drop-down menu listing User defined favorites.

2)	 Touch '+' to add the current airport to Favorites.

FltPlan Go - Airports Page - Favorites Menu

Touch to Select

Touch to Add Current Airport to Favorites

VIEW ON MAP

Touch  within the Airports section to view the airport on the Map.

	
NOTE: Online Maps are available for preflight planning when properly connected to Wi-Fi. To ensure the desired Maps will be avail-
able during flight, please download Maps to the device prior to departure.

SEARCH AIRPORTS
The next button located in the center of the Header Menu is Search Airports, where the current four letter airport identifier 

will be displayed (KXXX). Touch  to display a drop-down menu with a search bar that sorts the data into three main 
groups, United States (U.S.), Canada, and Other. The U.S. group lists the airports in alphabetical order by State (e.g. Alabama, 
California, Delaware, Washington, etc.). The Canada group lists the airports in alphabetical order by Province (e.g. Alberta, 
Ontario, Quebec, Yukon, etc.). The Other group lists the airports in alphabetical order by Country (e.g. Bahamas, Guatemala, 
Mexico, Venezuela, etc.). 
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Touch within the Seach Bar to manually enter text for an airport I.D. (e.g. TJIG, CYQA, KTEB), then select the desired airport 
to view the corresponding airport information.

FltPlan Go - Airports Page - Search Airports - U.S.

Touch to Enter Text

Touch to View Airports
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RUNWAY WIND CALCULATOR
The next button located in the Header Menu of the Airports Page is the Runway Wind Calculator. Touch  to 

display the Runway Wind Calculator page, where the appropriate runway, ref speed, target speed, and wind data can be entered 
and calculated. To set specific User Preferences related to Tailwind Caution, Tailwind Limit, X-Wind Caution, X-Wind Limit, 
Target Speed, Steady State Wind calculation, and Headwind calculation. Once the Preferences are set, the Wind Calculator will 
display the applicable annunciators when/if these limitations are exceeded.

 On the top of the page, the Headwind (Knots) and X-Wind (Knots) component will auto-fill as data is entered/adjusted. If 
wind gusts are entered, the Headwind and X-Wind numbers will 'flash' between the steady/constant wind component and the 
wind gust component. On the runway picture below the calculator, a blue arrow depicts the direction of the wind in relation 
to the selected runway and will change as data is entered/adjusted.

Entering/Adjusting Wind Calculator Preferences:

1)	 Touch  within the Airports section > Preferences.

2)	 Touch the desired text box and enter wind velocity (knots) and Target Speed preferences/limitations.

3)	 Touch Steady State Wind or Head Wind Comp to enter calculation(s). 

4)	 Touch '-' or '+' to adjust percentage calculation(s) for Steady State Wind or Head Wind Comp, as desired. 

5)	 Touch anywhere outside the Preferences dialogue box to exit, or touch the Close button to exit. 

FltPlan Go - Airports Page - Runway Wind Calculator - Preferences Menu

Touch to Enter Info

Touch to View/Adjust

Touch -/+ to Adjust

Touch to Enter Info
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Entering/Adjusting Wind Information:

1)	 Touch  within the Airports section.

2)	 Select the Desired Runway.

3)	 Adjust the Slider to the desired number for Wind From (Radial Measure in Degrees, e.g. 090 = From the East, 180 = From the 
South, etc.). Touch '-' or '+' to make small adjustments.

4)	 Adjust the Slider to the desired number for Wind Speed (Knots). Touch '-' or '+' to make small adjustments.

5)	 If necessary, adjust the Slider to the desired number for Wind Gusts (Knots). Touch '-' or '+' to make small adjustments.

6)	 If necessary, touch within the 'Ref Speed' box to enter the desired number (Knots). Touch '-' or '+' to make small adjustments. 
The Target Speed will autocalculate as data is entered/adjusted.

7)	 Touch the Back button to exit and return to the previous page.

FltPlan Go - Airports Page - Runway Wind Calculator

Touch to View/Edit PreferencesTouch to Change Airport

Selected Runway  
Used for Calculation

Crosswind 
ComponentHeadwind 

Component

Unfavorable 
Runway(s)

Touch -/+ to Adjust

Slide to Adjust

Relative Wind 
& Runway

Caution & 
Limit Exceeded 
Annunciator(s)

Touch -/+ to Adjust
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AIRPORTS NEAR ME

The next button located in the Header Menu of the Airports Page is Airports Near Me. Touch  to view a menu of 
airports near the current location of the device, listed from nearest to furthest. Touch the desired airport from the list to view 
the applicable airport information. 

	
NOTE: Location Services must be enabled on the device in order to accurately display Airports Near Me. Most devices list Location 
Services under Settings > Privacy.

Viewing Airports Near Me:

1)	 Touch  within the Airports section.

2)	 Touch desired airport from the list to view additional Airport Information.

FltPlan Go - Airports Page - Airports Near Me

Touch to View Airport Info

Distance From Airport

Longest Runway

City, State
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ADD TO BINDERS

The last button located in the Header Menu of the Airports Page is Add to Binders. Touch  to view a menu of Binders. 
Touch Add in the lower right corner to add the current airport to a Binder, which can be found quickly by pressing the Binders 
icon on the Main Menu.

 Adding Airport to Binder:

1)	 Touch  within the Airports section.

2)	 Touch the desired binder location where the current airport information will be saved.

Creating New Binder:

1)	 Touch  within the Airports section > 'Add'.

2)	 Enter the Binder name in the text box > Done to save or Cancel to close without saving.

FltPlan Go - Airports Page - Binders Menu

Touch to Select Binder

Touch to Create New BinderTouch to Exit

AIRPORT DIAGRAM
In the Airports section, directly below the top line of the Header Menu, the next group of buttons listed allow the User quick 

access to important information. One of the buttons is Airport Diagram, which will display a full-screen airport diagram if there 
is an FAA approved chart.

Touch the Airport Diagram button within the Airports section to view.

FltPlan Go - Airports Page - Info Buttons

Touch to View Info
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FltPlan Go - Airports Page - Airport Diagram - Main

Chart Effectivity 
Date Range
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When the Airport Diagram page is displayed, there will be a customized Banner Menu with quick access buttons that allow 
the User to efficiently navigate the FltPlan Go program. 

FltPlan Go - Airports Page - Airport Diagram - Banner Menu
Touch to Show Aircraft on Chart

Touch to Display GPS Track

Touch to Adjust Timestamp

Timer

Annotate

Lock Screen

Print

Email

Rotate 90° 

ENABLE SHIP

Touch the Enable Ship button to view your aircraft on the Chart.

	
NOTE: A GPS signal is required to view Aircraft position on the Chart.

BREADCRUMBS

Touch the Breadcrumbs button to display a green line that represents the actual GPS route taken by the aircraft.

ZULU TIME

Touch the Zulu Time button to display the Timestamp in Local (L) or Zulu (Z) format, then longpress on the Airport 
Diagram in the desired location to create a timestamp.

TIMER

Touch  to view the Timer. Touch Start to begin the Timer, Stop when desired, and then Reset to begin from zero. 
Touch the 'X' to close the Timer. 

FltPlan Go - Airports Page - Airport Diagram - Timer

Touch to Reset 

Touch to Close

Touch to Toggle Start/Stop

ANNOTATE

Touch  to view the Annotate options. Touch Color to select the color of the penstroke, e.g. Black, Red, Blue, Green,  
Yellow, etc. Touch Width to select the size of the penstroke. Touch the Undo arrow to remove the most recent annotation. 
Touch the Paintbrush to annotate, as desired. Touch the Pencil to draw freehand. Touch the 'Square' icon to create a square 
shaped annotation. Touch the 'Circle' icon to create a circular annotation. Touch the 'Save' icon to save the most recent 
annotation(s). Touch Done to exit the annotate process.

FltPlan Go - Airports Page - Airport Diagram - Annotate Icons

Undo

Save Create Square Paintbrush

DrawCreate Circle
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FltPlan Go - Airports Page - Airport Diagram - Annotate

Touch to Exit

Undo

Touch to Adjust Penstroke

Save PaintSelect Shape Draw
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LOCK SCREEN

Touch  to lock the screen orientation on the device. When the screen orientation is locked, the padlock icon will 
change to red. 

Touch  to unlock the screen orientation. The ability to Zoom In/Out and Annotate are not available when the screen 
orientation is locked.

PRINT

Touch  to Print and/or view Printer Options. Touch Select Printer to view previous and/or available printer options. 
Once a Printer has been selected, enter the desired number of Copies, select the Paper Size, Color, Orientation, Double-
sided, and Pages, then touch Print. Touch 'PDF' to download the file as a pdf which will be saved to the device and should 
be available for offline viewing. Touch the back button to exit.

FltPlan Go - Airports Page - Print Options

Touch to Save 
as PDF or Select 
Printer

Touch to Expand/
Collapse

EMAIL/SHARE

Touch  within the Airports section to display a menu listing available sharing and/or storage options (e.g.  Chrome, 
Nearby Share, Drive, Quick Share, Gmail, etc.).

Touch to Save to Recent Location

Touch to View/Adjust 
Device Visibility

FltPlan Go - NavLogs - Share/Save Menu

Touch to Select Sharing Method

Touch to View Additional Options

ROTATE IMAGE

Touch  to rotate the image 90° clockwise. 
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FBOS
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The first tab on the list is FBOs. Touch the FBO Tab to view all available FBOs. If there are multiple FBOs on the field, 
scroll right/left to view additional FBOs. Select the Services button to view car services, fuel prices, contact info, etc. Select the 
About button to view various details about the FBO, such as ammenities, mailing address, pilot/fuel rewards, etc. 

 

Scroll to View FBOs

FltPlan Go - Airports Page - FBOs

Touch to View

Touch to View Info



FltPlan Go for Android User's Guide190-02961-00 Rev A 20

Airports

Fl
tP

la
n 

A
cc

ou
nt

A
irp

or
ts

M
ap

s
N

av
Lo

gs
Ex

te
rn

al
Ch

ec
kl

ist
s

Bi
nd

er
s

W
ea

th
er

Fl
ig

ht
 

Tr
ac

ki
ng

To
ol

s
Sc

ra
tc

h 
Pa

d
Do

w
nl

oa
ds

Se
tti

ng
s

In
de

x

INFORMATION
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The second tab on the list is Information. Touch the Information Tab to view whether or not the airport is an Airport 
of Entry (AOE), Airport Eleveation (also known as Field Elevation, Runway Elevation, Aerodrome Elevation, Airport Height), 
Fuel Available (Jet and/or AVGAS), Latitude and Longtitude coordinates, Time Zone, and Magnetic Variation.

FltPlan Go - Airports Page - Information

Touch to View 
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FREQUENCIES
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The third tab on the list is Frequencies. Touch the Frequencies Tab to view all available frequencies, such as Clearance, 
ATIS, ASOS/AWOS, Ground, Tower, and CTAF. 

FltPlan Go - Airports Page - Frequencies

Touch to View 
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RUNWAYS
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The fourth tab on the list is Runways. Touch the Runways Tab to view the runway I.D., length, and width, e.g. 01/19 
is 7000' (length) x 150' (width).

FltPlan Go - Airports Page - Runways

Touch to View 

PROCEDURES
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The fifth tab on the list is Procedures. Touch the Procedures Tab to view filtered information in four categories, Airport, 
Instrument Approaches, STARs (Arrivals), and DP/SID Departures. Touch the Download All button to download all available 
procedrues for the selected airport. Touch the desired procedure to view, then the Back button to return. 

The first section lists information such as  Airport Diagram, Hot Spot(s), Takeoff Minimums, Diverse Vector Area, Alternate 
Minimums, etc. Instrument Approaches lists all precision and non-precision approaches. Standard Arrival Procedures (STARs) 
lists all available Arrivals. DP/SID Departures lists all available Standard Instrument Departures (SIDs) / Departure Procedures 
(DP). If a document is geo-referenced, a purple arrow will be displayed. If a document is downloaded, a green check mark will 
be displayed.
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FltPlan Go - Airports Page - Procedures

Touch to View 

Touch to Download 
All Procedures

Touch to View Info 
in Browser via 

FltPlan.com 

Geo-referenced 
Chart Available

Successfully 
Downloaded

Scroll to View 
Additional Info

Touch to View
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WEATHER
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The sixth tab on the list is Weather. Touch the Weather Tab to view METARs, Nearby Departure Airport METARs, 
Terminal Forecasts,  and PIREPs. Touch the Refresh button update weather information. A timestamp will appear on the top 
of the screen indicating the date and time of the most recent refresh.

FltPlan Go - Airports Page - Weather

Touch to Re-
fresh Data

Touch to View Info 
in Browser via 

FltPlan.com 

Touch to View

Data Refresh Info

Scroll to View 
Additional Info
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NOTE: A connection to Wi-Fi or ADS-B unit must be established to ensure current weather information.

MOS
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The seventh tab on the list is MOS. Touch the MOS Tab to view outlook weather forecasts which include details such as 
Ceilings (ft), Visibility (miles), Wind (compass direction and velocity in knots), Chance of Precipitation, and Temperature (°F). 
MOS forecasts provide weather data up to four (4) days out, presented in 3-hour windows, and refreshed hourly. To manually 
refresh the weather, touch the Reload Data button.

FltPlan Go - Airports Page - MOS

Touch to Re-
fresh Data

Touch to View

Scroll to View 
Additional Info
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NOTAMS
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The eighth tab on the list is NOTAMs. Touch the NOTAMs Tab to view NOTAMs, and FDC. To Refresh NOTAMs 
information, tap the Refresh button. A timestamp will appear on the top of the screen indicating the most recent refresh.

	
NOTE: A connection to Wi-Fi or ADS-B unit must be established to ensure current NOTAMs information.

FltPlan Go - Airports Page - NOTAMs

Touch to Re-
fresh Data

Touch to View

Scroll to View 
Additional Info

Data Refresh Info
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REMARKS
Located on the left side of the Airports section is a list of tabs that sort features/information associated with the selected 

airport. The ninth and final tab on the list is Remarks. Touch the Remarks Tab to view a list of FAA remarks, e.g. Traffic Pattern 
(Left or Right), After Hours Contact Info, Customs Data, Migratory Bird Activity, Engineered Matertials Arresting System 
(EMAS) Info, Approach Lighting, etc.

FltPlan Go - Airports Page - Remarks

Touch to View 

Scroll to View 
Additional Info

VIEW IN BROWSER
Throughout the FltPlan Go program, there will be the option to view the information in a web browser. Touching the View in 

Web Browser button will display a window confirming the desire to exit FltPlan Go and view the information via FltPlan.com. 

Touch No to stay within the FltPlan Go program. 

Touch Yes to exit FltPlan Go and launch FltPlan.com in a web browser.

FltPlan Go - Airports Page - View In Browser Confirmation

Touch to Stay in FltPlan Go Touch to View Info in Web Browser
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MAPS 
Selecting the Maps page allows the user to view the aircraft on a geo-referenced map with various layers of information.

FltPlan Go - Maps Page

Touch to View 
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HEADER MENU
The Header Menu is customized for each section (e.g. Airports, Maps, NavLogs, etc.) and contains various buttons to help the 

User navigate the FltPlan Go program quickly. In the Maps section, the available buttons include Airports Near Me, Map Settings/
Options, Split Screen, Zoom, Connectivity/Share, Route, Distance Measuring Tool, Timer, Account, Layers, Route, Edit, METARs, 
MOS, Winds, Weather (Wx), XM, and ADS-B.

FltPlan Go - Maps Page - Header Menu

Airports Near 
Current Location

Account Info

TimerSettings/Options Measure 
Distance

Split 
Screen Zoom Connectivity Current Route

Touch to View/Adjust

AIRPORTS NEAR ME

The first button located in the Header Menu of the Maps Page is Airports Near Me. Touch  to view a list of airports 
near the current location of the device, listed from nearest to furthest. Touch the desired airport from the list to view the 
applicable airport information. 

Viewing Airports Near Me:

1)	 Touch  within the Airports section.

2)	 Touch desired airport from the list to view additional Airport Information.

FltPlan Go - Airports Page - Airports Near Me

Touch to View Airport Info

Distance From Airport

Longest Runway

City, State
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NOTE: Location Services must be enabled on the device in order to accurately display Airports Near Me. Most devices list Location 
Services under Settings > Privacy.

MAP OPTIONS

Touch   to view a list with several options that include: North-up, Track-up, Track-forward, Downloaded Maps 
Only, Auto-center Position, Display Ship Position, Toggle Range Circle Rings, Display Route Fix Labels, Customize Route & 
Ship Icon, Runway/Airport Options, Toggle Breadcrumbs, Save Breadcrumbs, Clear Breadcrumbs, Breadcrumbs List, Go to 
Departure Airport, and Go to Arrival Airport.

FltPlan Go - Maps Page - Options

Touch to View/Adjust

Touch to Exit
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TRACK UP

Touch to point the Map in the direction of flight.

NORTH UP

Touch to change the Map orientation where North is always 'Up', no matter the direction of flight.

TRACK FORWARD

Touch to display only the area in front of the aircraft position, moving the aircraft to the 'bottom' of the Map.

DOWNLOADED MAPS ONLY

Toiuch to view maps that have been previously downloaded and are not being supplied via an active internet connection.

	
NOTE: Use Downloaded Maps Only after the applicable charts are downloaded via the Downloads section to ensure Maps will 
be displayed when the device is no longer connected to the internet.

AUTO-CENTER POSITION

Touch to automatically center the display on the aircraft.

DISPLAY SHIP POSITION

Touch to display an aircraft icon on the map representing the current position. 

TOGGLE RANGE CIRCLE RINGS

Touch to display range circles that center around the aircraft position at a defined distance, which can be helpful when 
visualizing distance and/or time out from a certin point. 

DISPLAY ROUTE FIX LABELS

Touch to display all route fixes and lables.
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CUSTOMIZE ROUTE & SHIP ICON

Touch Customize Route & Ship Icon to display a menu with options to edit the Aircraft Icon, Route Color and Opacity, 
and GPS Position. 

	4 Touch Jet, Prop, or Helicopter to adjust the Aircraft Icon shape. 

	4 Touch Small, Medium, or Large to adjust the Aircraft Icon size. 

	4 Touch the desired Aircraft Icon color. Aircraft Icon adjustments are made in real time to help the User identify the 
preferred display settings.

	4 Below the Aircraft Icon settings are the Route settings. Touch the desired Route color. 

	4 Slide the Route Line Opacity switch to the desired level.

FltPlan Go - Maps Page - Aircraft Icon Options

Touch to Adjust Icon Shape
Current Selection

Touch to Adjust Icon Size

Touch to Adjust Icon Color

Touch to Adjust Route Color

Slide to Adjust Route Opacity
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RUNWAY/AIRPORT OPTIONS

Touch to display a menu with settings for Show Runways on Map, Runway Color, Runway Icons, Standard Icons, and 
Airport Color. 

	4 Touch Show Runways on Map as desired, to adjust display on Map.

	4 Touch the desired Runway Color.

	4 Touch Runway Icons or Standard Icons, as desired. Standard Icons displays a 'ring' to depict the location of an 
airport. If Runway Icons is selected, the display includes the runway orientation within the depiction of the airport 
location, which can be enabled by touching Maps > Layers > Airports.

	
NOTE: An additional download may be required if 'Runway Icons' is selected..

FltPlan Go - Maps Page - Runway & Airport Icon Options

Touch to View/Adjust Icons

Touch to Toggle 'On/Off'

Touch to Adjust Runway Color

Touch to Adjust Airport Color
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TOGGLE BREADCRUMBS

Touch to enable the flight path tracking option for future playback and review. When enabled, a green checkmark will be 
displayed. Touch to toggle 'On/Off' as desired. 

SAVE BREADCRUMBS

Touch to display a pop-up window prompting the User to manually enter the name of the current breadcrumbs. Once the 
name has been entered, touch Save. 

CLEAR BREADCRUMBS

Touch to clear the current breadcrumbs displayed on the Map.

BREADCRUMBS LIST

Touch to view Saved Breadcrumbs and Online Breadcrumbs.

	4 Touch Saved Breadcrumbs to view a pop-up window with the options to Open, Email, Rename, Upload to FltPlan.
com, and Delete.

	4 Touch Open Breadcrumbs to view the track on the Map, along with a pop-up window in the top right corner with 
playback options.

	4 Touch Breadcrumbs Playback to view a pop-up window with several options, including Play, Pause, and Stop. 
Flight Duration is presented in hours, minutes, and seconds. Speed Option(s), and Flight Percentage are displayed 
via progress bar. Touch Play and the breadcrumbs from your flight will populate the map. Touch Pause to pause the 
playback and keep the breadcrumbs on the Map. Touch Stop to exit breadcrumbs playback.

	4 Slide the Speed Bar, which has two icons indicating an increased playback rate (rabbit) or a slower playback rate 
(turtle)as desirec.

	4 The Flight Percentage Bar is located on the right side, and indicates the percentage of the flight that has been 
completed.

	4 Touch Online Breadcrumbs to display a pop-up window with the options to Delete or Download. Touch Delete to 
remove breadcrumbs. Touch Download to download a set of breadcrumbs and store offline. 

	4 Touch Google Earth and a prompt will appear with the options to email and create a KML file of the selected 
breadcrumbs. Touch the downloaded KML file to view via Google Earth.

	4 Touch Email Breadcrumbs to display a pop-up window with a User generated list of saved breadcrumbs as the body 
of the email. Enter desried text to compose the email and send. The recipient will be able to open the breadcrumbs 
from the email via FltPlan Go.

	4 Touch Upload to FltPlan.com to save your breadcrumbs to FltPlan.com, allowing the User to access the breadcrumbs 
from both FltPlan.com and the FltPlan Go program.

GO TO DEPARTURE AIRPORT

Touch to redirect the Airports section to the Departure Airport listed in the route.

GO TO ARRIVAL AIRPORT

Touch to redirect the Airports section to the Arrival Airport listed in the route. 
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SPLIT SCREEN

Touch  to display a menu with various Split Screen options that can be displayed simultaneously, such as; Airports, 
Departure Airport Procedures, Arrival Airport Procedures, NavLogs, Howgozit, Weather, ScratchPad, and Tools. Touch the 
desired display option to view one of the Split Screen Options in conjuction with with Maps or NavLogs simultanesously, in 
either vertical or horizontal orientation. 

FltPlan Go - Maps - Split Screen Options Menu

Touch to View Airport NOTAMs, 
A/FD & Weather

Touch to View Airport Procedures/Charts

Touch to View

Touch to View Temperature, 
Performance Calculators
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FltPlan Go - Maps - Split Screen - Procedures - Departure

Reverse Route

Clear Route

Touch to View Split Screen Options 

Touch to Animate 
Weather

Add Present 
Position to Route

Save Route

Save & File Route

Touch When 
Finished

Add/Delete 
User Waypoints
View Available 
Procedures
Add Search & 
Rescue Grid

Quality of GPS 
Signal 

Swipe Left/Right to 
View/Hide GPS-
Derived Data 
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ZOOM 

Touch  to display a menu with the following options;  Zoom to Present Position, Zoom to Departure Airport, Zoom to 
Arrival Airport, Zoom to Full Route, and Zoom to Breadcrumbs. Touch the desired Zoom option to view the area on the Map. 

FltPlan Go - Maps Page - Zoom Options

Touch to View

CONNECTIVITY

Touch  to display a menu with options to Export Flight Plan and Share Flight Plan.

GARMIN PILOT

Touch the Upload Route button to transfer the route of flight to Garmin Pilot. When connected to a compatible Garmin 
avionics suite that supports flight plan transfers, the avionics will be displayed as an option to export the route of flight.

FltPlan Go - Maps Page - Connectivity Options

Touch to Upload Current Route to Garmin Pilot

	
NOTE: To aid in Flight Plan transfer, please ensure the desired external piece of equipment is connected via the External Page prior 
to attempting the flight plan transfer.

JEPPESEN FLITEDECK

Touch to send the current route of flight to a properly configured and connected piece of Jeppesen equipment.

DYNON

Touch to send the current route of flight to a properly configured and connected piece of Dynon equipment. 

AVIDYNE

Touch to send the current route of flight to a properly configured and connected piece of Avidyne equipment.
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MY ROUTES

Touch the button at the top, center, with the Departure and Arrival airport ID's, e.g.  to display a menu 
listing Local Routes and Account Routes.

To Delete a Saved Route, long press the desired route and touch Yes, when prompted, to delete the route.

To Refresh My Routes, touch Refresh Routes at the bottom of the My Routes menu.

FltPlan Go - Maps Page - Routes

Touch to Create New Route

Touch to Load Route

AUTO SYNCING ROUTES

When a flight plan is created in FltPlan.com, the flight information, including NavLogs, Routes, Weight & Balance 
Calculations, and Checklists, are synced to the FltPlan Go program. 
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Touch to View

FltPlan Go - Maps Page - Route With Waypoints

Scroll to View 
Additional Info

Distance Between 
Waypoints

Distance to 
Destination
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DISTANCE MEASURING TOOL

Touch  to display the Meaure Tool window, then touch anywhere on the Map to drop the first 'pin'. Touch anywhere 
on the Map to drop another 'pin' which will display the Total distance in the Measure Tool window. Multiple 'pins' can be 
created on the Map with the distance between the points listed in Nautical Miles (nm) on the Map. 

FltPlan Go - Maps - Distance Measuring Tool

Touch to Reset

Touch to View 
Distance Measuring 
Tool

Distance Between 
Two Points

Touch to Close
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TIMER

Touch  to view the Timer. 

Touch Start to begin the Timer, Stop when desired, and then Reset to begin from zero. Touch the 'X' to close the Timer. 

FltPlan Go - Maps - Timer

Touch to Reset 

Touch to Close

Touch to Toggle Start/Stop

ACCOUNT
Touch the button in the top right corner, e.g.  to Add Account or Logout.

LAYERS
Touch Layers to view the available Online base maps, Offline maps/charts, and Overlay options.

ONLINE

Touch any of the options listed in the Online section, which include: North America, World, Satellite, Street, Topographic, 
and Shaded Relief. 

FltPlan Go - Maps - Layers - Online Menu

Touch to View

Current Selections

Touch to Display

	
NOTE: When the Downloaded Maps Only options is toggled 'On', a pop-up window will appear stating the User cannot view Online 
Maps. At the bottom of the pop-up window, touch Turn off Downloaded Maps Only to view both downloaded and online maps. 
To turn Downloaded Maps Only back on, touch Map Options > Maps > Downloaded Maps Only.
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OFFLINE

Touch any of the options listed in the Offline section, which include: Sectionals, Jet High, Victor Low, TACs, Helicopter, 
IFR Terminal, United States, Canada, and Caribbean.

FltPlan Go - Maps - Layers - Offline Menu

Touch to View

Current Selections

Touch to Display

OVERLAY

Touch any of the options listed in the Overlay section, which include: Customs, Temporary Flight Restrictions (TFRs), 
Stadiums, Airports, Fuel Prices (AvGas or Jet Fuel), Stadiums, State Outline, and Civil Air Patrol (CAP) Search Grid. Touch 
Refresh to update overlay data. 

The User can adjust TFR, Stadium, and State Outline opacity by touching Options and moving the slider as desired. 

FltPlan Go - Maps - Layers - Overlay Menu

Touch to View

Current Selections
Touch to Display

Touch to Display 
Opacity Options

Touch to Refresh 
Overlay Data

FltPlan Go - Maps - Layers - Overlay - Options 

Slide to Adjust
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Customs

Touch Customs to display United States and Canadian customs locations on the Map. Touch the flag icon to view 
additional information.

FltPlan Go - Maps - Layers - Overlay - Customs

Touch to Toggle 
Overlay 'On/Off'

Touch to View 
Customs Info

Touch to View

Touch to Close



FltPlan Go for Android User's Guide190-02961-00 Rev A 44

Maps

Fl
tP

la
n 

A
cc

ou
nt

A
irp

or
ts

M
ap

s
N

av
Lo

gs
Ex

te
rn

al
Ch

ec
kl

ist
s

Bi
nd

er
s

W
ea

th
er

Fl
ig

ht
 

Tr
ac

ki
ng

To
ol

s
Sc

ra
tc

h 
Pa

d
Do

w
nl

oa
ds

Se
tti

ng
s

In
de

x

 Temporary Flight Restrictions (TFRs)

Touch TFRs to display on the Map, which will be depicted by a Red circle. When online, the TFRs will automatically 
update everytime the Layers tab is selected, and present a time stamp (HH:MM) in Zulu time. Touch the TFR for additional 
information. 

Touch Refresh to manually update Overlay data.

FltPlan Go - Maps - Layers - Overlay - TFRs

Touch to Toggle 
Overlay 'On/Off'

Scroll to View Info

Touch to View Info

Touch to View 
Additional TFR(s)
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State Outline

	
NOTE: The State Outline layer has to be downloaded prior to viewing via Downloads > Maps > Layers > STB.

Touch State Outline to display a red outline defining each state's border. The User can adjust TFR, Stadium, and State 
Outline opacity by touching Options and moving the slider as desired.

FltPlan Go - Maps - Layers - Overlay - State Outline

Touch to Toggle 
Overlay 'On/Off'

Touch to View/
Adjust State 

Outline Opacity

FltPlan Go - Maps - Layers - Overlay - Options 

Slide to Adjust
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Airports

Touch Airports to display all airports on the Map. Touch an airport icon to display additional information, such as 
Latitude, Longitude, City,  and Fuel. 

Touch View Runways to display the runway I.D., length and width. 

Touch View Airport to view the selected airport in the Airports tab within Garmin Pilot. 

Touch View Procedures to display the available charts and procedures.

FltPlan Go - Maps - Layers - Overlay - Airports

Touch to Toggle 
Overlay 'On/Off'

Touch to View Info

Touch to View in 
Airports Tab
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Fuel Prices

Touch Fuel Prices to display the price per gallon on the Map, then touch the desired octane, AvGas or Jet Fuel. A circle 
will be displayed with the airport ID, whether or not the fuel is Self Serve 'S', or Full Service 'F', and the price per gallon. 
Touch the circle to view additional information, e.g. Name of the FBO that provides the Fuel Service, Hours of Availability, 
After Hours Contact Info, Fuel Programs, etc.

FltPlan Go - Maps - Layers - Overlay - Fuel Prices - AvGas

Full Service Price 
Per GallonSelf Service Price 

Per Gallon

Touch to Toggle 
'On/Off'

Touch to Display

Touch to View 
Info
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Stadiums

Touch Stadiums to display Temporary Flight Restrictions (TFRs) related to a Stadium. Touch the Stadium icon to view 
additional information. If there are multiple stadiums within the same area, touch Next to view additional info. 

The User can adjust TFR, Stadium, and State Outline opacity by touching Options and moving the slider as desired. 

FltPlan Go - Maps - Layers - Overlay - Stadiums

Touch to Toggle 
'On'Off'

Touch to View Info

Stadium TFR Info

Touch to View 
Additional Stadium 
TFR

Touch to View/
Adjust Stadium 

TFR Opacity

FltPlan Go - Maps - Layers - Overlay - Options 

Slide to Adjust
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Civil Air Patrol (CAP) Search Grid

	
NOTE: The CAP Search Grid layer has to be downloaded prior to viewing via Downloads > Maps > Layers > CAP.

Touch CAP Search Grid to create a grid pattern, labeled and separated into quadrants, to aid in a Search and Rescue event. 

FltPlan Go - Maps - Layers - Overlay - CAP Search Grid

Touch to Toggle 
'On/Off'
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ROUTE
Touch Route to display informatoin regarding the planned route of flight, which includes: From, To, Distance (nm), Course, 

Time To (hhmm), Leg (nm), Arrival. 

	
NOTE: The Route feature provides information that is intended for in-flight use. Once airborne, the various data points, e.g. Time To, 
Arrival, etc., will be calculated and displayed in real-time. 

Scroll to View 
Additional 
Waypoints

FltPlan Go - Maps Page - Route With Waypoints - U.S.
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GRAPHICALLY EDIT ROUTE

Long press on the Route to activate the 'rubber band', which allows the User to manually edit the Route to include an 
Airport, Navaid, or Waypoint.

Touch the arrow to expland or collapse the options bar, then select Direct To, Add to Route, or Info, as desired. 

Touch Close to exit without saving.

FltPlan Go - Maps Page - Manually Adjust Route

Touch to Expand/
Collapse

Touch to Go 
Direct To 

Touch to Add to 
Route

Touch to View Info

Touch to Close

EDIT
Touch Edit to adjust flight plans that have been synced from the associated FltPlan.com account. Touch within the Edit box 

to manually enter text via the keyboard.

FltPlan Go - Maps Page - Edit

Touch to Clear 
Route Data

Touch to View

Add/Delete 
User Waypoints
View Available 
Procedures
Add Search & 
Rescue Grid

Add Present 
Position to Route

Reverse Route

Save Route

Save & File Route

Touch When 
Finished
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On the left side of the Edit menu, there are buttons to help the User complete standard tasks quickly: Reverse, P/P, Save, and 
Save/File. 

REVERSE

Touch the Reverse button to keep all the same fixes, but reverse the route.

P/P

Touch the P/P button to load the Latitude and Longitue (Lat/Long) of the User's Present Position as a fix within the route

SAVE

Touch the Save button to save the route(s) locally to the FltPlan Go program.

SAVE/FILE

Touch the Save/File button to display a pop-up window with the following options: Web, which allows the User to create 
a flight plan on the Web via Fltplan.com, or App, which allows the User to file the flight plan via the FltPlan Go program.

 FltPlan Go - Maps - Edit - Save/File - App Options

Touch to Enter Info

Touch to Exit Touch to Save & File 
via FltPlan Go

Touch to Refresh Data
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On the right side of the Edit menu, there are buttons to help the User complete standard tasks quickly: Waypoints, Procedures, 
and S/R Grid.

WAYPOINTS

Touch the Waypoints button to view and/or add User Waypoints. To create a Waypoint, touch the Add button to enter the 
Name, Description, and Location (Lat/Long), then touch Add. Touch Show All to view Waypoints on the Map.

Touch Export and select the desired program to share/save the Waypoint.

To delete a Waypoint, longpress the Waypoint to display a pop-up window confirming the desire to Delete, then touch Yes.

FltPlan Go - Maps Page - Edit - Waypoints - Create

Touch to Enter Info

Touch to Save

Touch to Cancel

Touch to View/Edit Waypoints

FltPlan Go - Maps Page - Edit - Waypoints Menu

Longpress to Delete

Touch to Create Waypoint

Touch to Display All on Map

Touch to Delete All

Touch to Export
Touch to Exit
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FltPlan Go - Maps Page - Edit - User Waypoint Displayed

User Waypoint
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PROCEDURES

Touch the Procedures button to view available Stardard Instrument Departures (SIDs), Standard Arrival Routes (STARs) 
or Approaches on the Map. 

	
NOTE: Not all airports have approved government approved Procedures. If this is the case, a textual note will be displayed stating-
such, e.g. 'No Sid/Stars Available For Airport'.

FltPlan Go - Maps Page - Edit - Procedures - Arrivals

Touch to Add 
to Route

Touch to View

Current Route

Touch 
to View 
Available 
Procedures

Touch to View

Adding a Procedure:

1)	 Touch  in the bottom right corner of the Map to view the Procedures Options menu listing Opacity, Departures, 
Arrivals, and Approaches.

2)	 Touch Departures to view a list of available SIDs for the Departure Airport.

3)	 Touch Arrivals to view a list of available STARs for the Destination Airport.

4)	 Touch Approaches to view a list of available Instrument Approaches for the Destination Airport. 

5)	 Touch the Add To  button to incorporate the procedure into the Route. 

6)	 Touch the Procedure button to view the Procedure in Split Screen mode. 
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FltPlan Go - Maps Page - Edit - Procedures - Options

Touch to Load Available Departures Touch to Load Available Arrivals

Touch to View Available Approaches

Slide to Adjust Chart 
Overlay Opacity

Touch to Remove Current ProcedureTouch to Exit

FltPlan Go - Maps Page - Edit - Procedures - Arrivals

Current Selection

Slide to Adjust Chart 
Overlay Opacity

Touch to Remove Current ProcedureTouch to Exit

Touch to Select 

Scroll to View Additional Info
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7)	 Once a Procedure is loaded, touch  in the bottom right corner of the Map to view a secondary Procedures Options menu, 
listing Opacity, Airport, Procedures, and Approaches.

FltPlan Go - Maps Page - Edit - Procedures - SID / STAR Options

Touch to View Chart in Split Screen

Touch to Expand/Collapse

Touch to Remove Current ProcedureTouch to Exit

Touch to Add Procedure to Route

Touch to Show All on Map

8)	 Touch the desired fix along the SID/STAR, then press the Procedure button to view the chart in Split Screen mode.

FltPlan Go - Maps Page - Edit - Procedures - STAR - Split Screen

Current Route

Touch to 
Rotate 
Image 90°
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FltPlan Go - Maps Page - Edit - Procedures - Approaches

Successfully Downloaded

Touch to Download All Procedures

Touch to Select 

Scroll to View Additional Info
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Current Selection

FltPlan Go - Maps Page - Edit - Procedures - Approach - Split Screen

Current Route
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FltPlan Go - Maps Page - Edit - Procedures - Departures

Current Selection

Slide to Adjust Chart 
Overlay Opacity

Touch to Remove Current ProcedureTouch to Exit

Touch to Select 

Scroll to View Additional Info
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Current Selection

FltPlan Go - Maps Page - Edit - Procedures - SID Selection on Map

Touch to View 
Options

Touch to View

Touch to Add 
Procedure to Route

Current Route
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Current Selection

FltPlan Go - Maps Page - Edit - Procedures - SID on Map - Split Screen

Touch to View 
Options

Current Route

Procedure 
Added to Route
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SR GRID

Touch the SR Grid button to input the desired grid details, which include the Waypoint, Pattern (Parallel, Sector, Expanding 
Square, Creeping Line, Route, or Grid Aligned), Initial Degrees, Initial Turn, Leg Length (nm), Space Length, (nm), and Leg 
Count.

Touch Add to display the SR Grind on the map. 

Touch Cancel to close without saving. Each leg of the SR Grid will be displayed in the 'Edit' window along with a Map 
overlay. 

Touch Clear to remove the SR Grid. 

FltPlan Go - Maps Page - Edit - SR Grid Options

Touch to Enter / Adjust Info

Touch to Save & View SAR Grid on MapTouch to Close Without Saving
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FltPlan Go - Maps Page - Edit - SAR Grid

Touch to Clear 
Grid Pattern

IMPORTING KMZ, KML, CSV, CUSTOM WAYPOINTS

The FltPlan Go program allows the User to send various file types from a device. The first step is getting the file on the 
device to allow for an upload to FltPlan Go. One way to accomplish this task would be emailing the file to yourself, then 
opening the file from your device running FltPlan Go, then touch the emailed attachment to allow FltPlan Go to open the 
file automatically, or prompt the User with other program options that can open the file. 

Another option would be to Airdrop the files onto the device running FltPlan Go. 

	
NOTE: To import a CSV file, the formatting must follow the exact format template to be rendered transferable: WAYPOINT, LAT, 
LONG, DESCRIPTION.
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METARS
Touch the METARs tab to display a drop-down menu with settings for Ceiling, Visibility, Wind Speed, and Temperature. 

Touch the text box with a numeric value to adjust the color coded circles (magenta, red, blue, or green) as desired to align with 
personal and/or equipment limitations. These circles will then be displayed based on the Map, allowing the User to view airport 
METARs across the country at a glance. Toggle the checkmark On/Off next to Show METARs Layer, Ceiling, Visibility, Wind 
Speed, and Temperature. The parameters of a route will be automatically tabulated with the default METARs data settings. 
After inputing and adjusting the parameters, the User can return to the default settings by touching the Reset Defaults button. 

Touch the Refresh button to update the weather data.

Touch a METAR circle on the map to display information for the selected airport. 

FltPlan Go - Maps Page - METARs Overlay

Touch to 
Toggle Display 

On/Off

Touch to ResetData Refresh Info

Touch to Refresh

Touch to Adjust
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Touch the dot at an airport on the Map to view the METAR details via pop-up window displaying the Airport ID, e.g. KLWC, 
Ceiling (ft), Visibility (sm), Wind Speed (kts), and Temperature. The color of the dot will be represented by the most severe 
of the selected weather conditions. 

At the bottom of the pop-up window, there are two buttons, View Procedures and View Airport. Touch the View Procedures 
button to view instrument procedures for selected airport. Touch the View Airports button to open the Airports Tab for the 
selected airport.

 FltPlan Go - Maps Page - METARs - Individual Airport

Touch to View InfoTouch to View Info

Touch to Close

MOS
Model Output Statistics (MOS) forecasts include important and practical details necessary for pre-flight planning. Potentially 

significant, location-specific factors such as terrain characteristics and weather anomalies not accounted for in traditional 
forecasts are factored into the MOS forecast. MOS forecasts provide weather data for up to 4 days out, presented in 3-hour 
windows, and refreshed hourly. FltPlan.com's MOS weather on FltPlan Go is unique, as the extra layer of information along 
the route of flight is easy to read quickly for more than 2,000 airports. Should the destination airport not have a MOS forecast, 
Flight Plan Go will provide information for the nearest MOS reporting airport.

Touch the MOS tab to display a menu which lists options for the MOS layer: Ceiling (ft), Wind Speed (knots), Visibility 
(miles), Temperature (°F), Date (Day of the Week, MM/DD/YYYY), and a Zulu Time (HH:MM). 

Enabling MOS:

1)	 Toggle the checkmark On/Off next to Ceiling, Visibility, Wind Speed, and Temperature. 

2)	 Touch the desired Date and Time.

3)	 Touch the Legend button to view the parameters for color designation. 

4)	 Touch the Refresh button to  update the weather data.

5)	 Touch the Display bnutton to enable the MOS overlay.

6)	 Touch the Remove button to disable the MOS overlay.

7)	 Touch a MOS circle on the map to display information for the selected airport. 
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FltPlan Go - Maps Page - MOS Overlay

Touch to Toggle 
Display On/Off

Touch to Refresh 
Weather Data

Touch to Select 
Timeframe

Touch to View

Touch to Adjust

Touch to Display 
MOS Data

Touch to Remove 
MOS Data

Touch to View

Touch to View

FltPlan Go - Maps - MOS Legend & MOS Forecast Individual Airport

Touch to Refresh Weather Data
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WINDS

	
NOTE: An internet connection must be established to view Wind information.

Touch the Winds tab to display a menu listing the following overlay options; Wind Speed (knots) and Altitude (ft), United 
States / CONUS, Canada / Alaska. Winds can be displayed as either Color Coded Arrows or Wind Barbs. 

Enabling Winds:

1)	 Toggle the checkmark On/Off next to Wind Speed.

2)	 Touch the altitude box and select desired altitude. 

3)	 Toggle the checkmark next to United States/CONUS (Continental United States), Canada/Alaska, Northern Hemisphere. 

4)	 If necessary, toggle the checkmark next to Use Low/Slow Scale, for details related to lower altitudes. 

5)	 Adjust the overlay display by selecting Color Coded Arrows or Wind Barbs. 

FltPlan Go - Maps Page - Winds - Color Coded Arrows Overlay - High Altitude

Touch to Toggle 
Display On/Off

Touch to Toggle 
On/Off

Data Refresh Info Touch to Refresh 
Weather Data

Touch to Select 
Altitude

Touch to View Info

Touch to Close

Touch to View
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When Color Coded Arrows are initially selected, the default wind velocity scale ranges from 30 knots to 150 knots, but there 
will be an additional option to view the winds on a different scale entitled 'Use Low/Slow Scale'. Enabling this option will adjust 
the wind velocity scale range to 10 knots to 45 knots. 

Toggle the checkmark On/Off next to Use Low/Slow Scale, as desired. 

FltPlan Go - Maps Page - Winds - Color Coded Arrows Overlay - Low/Slow

Touch to Toggle 
Display On/Off

Touch to Toggle 
On/Off

Data Refresh Info Touch to Refresh 
Weather Data

Touch to Select 
Altitude

Touch to View Info

Touch to Close

Touch to View
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Touch the wind indicator (arrow or barb) on the Map to view specific information detailing the Altitude (ft), Direction (radial 
degrees), Wind speed (kts) and Temperature (°C). 

Touch the Refresh button to update the weather data.

FltPlan Go - Maps Page - Winds - Wind Barbs

Touch to Toggle 
Display On/Off

Data Refresh Info Touch to Refresh 
Weather Data

Touch to Select 
Altitude

Touch to View Info

Touch to Close

Touch to View

WEATHER (WX)

	
NOTE: An internet connection must be established to view information within the Weather tab.

	
NOTE: Radar animation is not available when multiple Radar layers are selected. 

Touch the Weather tab to display a menu listing Baron Weather options, such as; U.S. Radar, Canadian Radar, Alaskan Radar, 
Surface Analysis, IR Satellite, Visible Satellite, Echo Tops, and Lightning. 
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Enabling Weather:

1)	 Toggle the desired layers On/Off by touching the checkmark. 

2)	 Slide the Weather Opacity tool, as desired.

3)	 When a Radar option is enabled  will be displayed in the bottom right corner of the Map. 

4)	 Touch  to animate the weather in 10 minute intervals, then  to stop animation.

FltPlan Go - Maps - Weather - U.S. Radar & Lightning

Touch to Refresh
Data Refresh Info

Touch to Toggle 
On/Off

Touch to View

Touch to Toggle 
Animation On/Off

Slide to Adjust 
Weather Opacity
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XM (OPTIONAL)
Touch the XM button to view connection options. Touch either Connect via WiFi, or Connect via GDC64. 

Connecting to Baron Mobile Link System

1)	 From the device, e.g. Samsung Galaxy S7 Tab, go to Settings and connect the WiFi to Mobile Link.

2)	 Once the Mobile Link is connected, there will be a slight delay to allow the XM Receiver to fully initialize (this can take several 
minutes).

3)	 Open FltPlan Go.

4)	 Touch the Maps tab > XM.

	
NOTE: If an error is received when navigating to the XM weather menu, the most common cause is due to the lengthy initializing 
stage required for the XM Radio. 

5)	 From the XM menu, touch the desired weather to display.

ADS-B
Once an ADS-B device has been connected via the External tab, touch Maps > ADS-B to display a menu listing available 

data overlays, graphics, and information.The first colum contains the options, CONUS (Continental United States) Radar, 
Regional Radar, PIREPs, NOTAMs, METARs, TAFs, Traffic, and Traffic Breadcrumbs. Once enabled, the PIREPs, NOTAMs, 
METARs and TAFs will be overlayed on the Map. NOTAMs appear as purple squares, METARs as green squares, and TAFs as 
blue squares. PIREPs will be displayed via the appropriate symbol. Touch the weather and traffic icons on the Map to view 
additional information.

Touch  next to Traffic to display the legend and options, which include Minimize Distant Traffic, Hide Distant Traffic, 
and Display Relative Altitude. 

	4 Enable Minimize Distant Traffic to hide the gray ring around the traffic. 

	4 Enable Hide Distant Traffic to hide the distant traffic.

	4 Enable Display Relative Altitude to display the relative altitude of the traffic.

The second column within the ADS-B menu contains information detailing the number of weather stations used to collect 
data. Touch Refresh to refresh the connection.Touch Disconnect to remove the device connection.

FltPlan Go - Maps - ADS-B - Traffic Legend & Settings

Touch to Enter Info

Touch to Toggle 'On/Off'
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FltPlan Go - Maps - ADS-B

Touch to Refresh 
ADS-B Connection

Touch to Remove 
ADS-B Connection

Touch to View

Slide to Adjust 
Opacity

Touch to View Info

Current Location

Touch to 
Toggle On/Off

Touch to View/
Adjust Settings

Selected Traffic Info

	
NOTE: The User must be connected to an ADS-B device in order to receive current Weather, NOTAMs, TAFs, METARs, AIRMETs, and 
SIGMETs. 
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HEAD-UP DISPLAY (HUD)
Located on the bottom of the screen, the HUD displays flight information, which includes; GPS Accuracy, Ground Speed, 

Lat/Long, Altitude, and True Course. This information is updated in real time based upon the tablet's GPS or a properly 
configured and connected external GPS / ADS-B device. If the HUD is hidden, touch in the bottom right corner and then slide 
Left, across the screen, to display the HUD. To hide the HUD information banner, slide the information banner to the Right. 

FltPlan Go - Maps - GPS Signal Acquired

Slide Right to 
Hide HUD Info

AUTO CENTER

The Auto Center button is located in the bottom right corner, just above the HUD information banner. Touch  to 
center the Map to the current location of the aircraft. When activated, the Auto Center button appears green  and will 
automatically recenter the Map back to the aircraft after the User is done scrolling. To disable the Auto Center feature, touch 

 again, turning the button grey.
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NAVLOGS 
Selecting the NavLogs icon from the Home Menu will guide the User to NavLog section, highlighting NavLog Options, Split 

Screen Options, Connectivity, My NavLogs/WX, Share/Save Options, Print Options, and Account Options. 

FltPlan Go - NavLogs

Touch to View/
Download NavLog

Scroll to View 
Additional Info

FltPlan Go - NavLogs - Banner Menu

NavLog 
Options

Connectivity 
Options Touch to View Saved/Online NavLogs

Split Screen Options

Touch to Logout 
or Add AccountPrint Options

Email/Share Options
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NAVLOG OPTIONS

The first button in the NavLogs banner menu is Options. Touch  to view a menu with the following options: Refresh 
Current NavLog, Download all NavLogs for Today, Departure Airport, and Arrival Airport.

FltPlan Go - NavLogs - Options

Touch to View/Select

REFRESH CURRENT NAVLOG

Touch Refresh Current NavLog to refresh/update the NavLog following any route changes or weather updates. 

Touch Download All NavLogs for Today to downlaod NavLogs dated for today. Once all NavLogs have been downloaded 
a green message will appear stating 'NavLogs Downloaded'.

Touch Departure Airport to be redirected to the Airports Page, highlighting the departure airport's information.

Touch Arrival Airport to be redirected to the Airports Page, highlighting the arrival airport's information.

SPLIT SCREEN OPTIONS

Touch  to display a drop-down menu with various Split Screen options that can be displayed simultaneously, such 
as; Airports, Flight Instruments (AHRS), Departure Airport Procedures, Arrival Airport Procedures, Howgozit, Checklsit, 
and Weather. Touch the desired display option to view one of the Split Screen Options in conjuction with with NavLogs 
simultanesously, in either vertical or horizontal orientation. 

FltPlan Go - NavLogs - Split Screen Options

Touch to View Dep & Arr Airport 
NOTAMs, A/FD, & Weather

Touch to View Airport Procedures

Touch to View/Log Expected vs. Actual 
Fuel Burn Differences 

Touch to Temp, Density Altitude, 
& Equal Time Calculators

Touch to View Weather for Route

Touch to View Scratch Pad
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FltPlan Go - NavLogs - Split Screen - Weather

Touch to Refresh 
Weather Data

Touch to Change 
Airport

Scroll to View 
Additional Info
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HOWGOZIT 

	
NOTE: Prior to selecting Howgozit, please ensure the the correct route is selected by touching the route from the drop-down menu 
or creating the route by touching Maps > Edit.

	
NOTE: Please ensure the latest NavLog is downloaded to ensure the best data is available for calculations.

Within the Split Screen Options menu, touch Howgozit to log flight times, legs, and fuel burn in real time. This data is 
then compared with projections/expectations and generates a score based upon actual flight/leg time vs. expected fuel burn. 

FltPlan Go - NavLogs - Split Screen Options

Touch to View Dep & Arr Airport 
NOTAMs, A/FD, & Weather

Touch to View Airport Procedures

Touch to View/Log Expected vs. Actual 
Fuel Burn Differences 

Touch to Temp, Density Altitude, 
& Equal Time Calculators

Touch to View Weather for Route

Touch to View Scratch Pad

To enter data points along the route, the User, upon passing a waypoint, will enter the time over the waypoint and the fuel 
on board. Howgozit then displays a new accurate ETA and fuel on board upon landing. If the User's device has GPS signal, 
Howgozit will automatically display the time over the fix without User intervention. 

	
NOTE: The autogenerated Howgozit times over a fix are based upon the NavLog ground speed, not the current ground speed. 

Touch  to display a pop-up window with the Departure Date (MM/DD/YYYY), Time (HH:MMZ), and Now buttons 
at the top. Touch the Departure Date button to display the date currently imported from the NavLog. To change the Date, 
touch the date listed in the secondary pop-up window, then set the date by 'spinning' the Month, Date, and Year. 

Touch OK to save, or Cancel to exit without saving.

 FltPlan Go - NavLogs - Split Screen - Howgozit - Settings - Date Selection

Touch to Display Calendar

Touch to Change Date
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Touch the Departure Time button to display the time currently imported from the NavLog. To change the Departure Time, 
touch the time listed in the secondary pop-up window, then set the time by 'spinning' the hours and minutes accordingly.

FltPlan Go - NavLogs - Split Screen - Howgozit - Settings - Time Selection

Touch to Display Time

Touch to Set Time

Touch the Now button to set the departure date and time to the present date and time.

Enter Fuel On Board manually (lbs) and touch Ok to save the data, or Close to exit without saving. 

Touch Howgozit to display the following data that was pulled from the NavLog: Departure (Zulu), Estimated Arrival 
(Zulu), Updated Arrival (Zulu), Updated Landing Fuel, and various fixes along the route. Touch the checkmark next to Auto 
Update to allow the GPS to automatically calculate the Estimated Time of Arrival (ETA), Actual Time of Arrival (ATA), and 
Score during the flight. 

FltPlan Go - NavLogs - Split Screen - Howgozit

Touch to Adjust 
Time/Fuel on Board 
Upon Arrival to Fix

Touch to View/
Adjust

Touch to 
Toggle On/Off
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Once the fixes along the route have been imported, the User can adjust the Arrival Data by touching the desired fix/
waypoint which displays a window for Arrival data. Enter the Time (Zulu) or press the Now button to load the current time. 
Touch within the Fuel on Board text box to manually enter information. 

Touch OK to save any adjustments. 

Touch Delete to remove the fix/waypoint from the route. 

Touch Close to exit without saving. 

Once the data has been entered, the Howgozit section will calculate a Score for each leg and present the data as green text 
if there was an improvement from the NavLog expectations, black text if the data was the same as the NavLog expectations, 
or red text if the data was a downgrade from the NavLog expectations.

FltPlan Go - NavLogs - Split Screen - Howgozit Scores

Touch to View 
Howgozit Settings

'Score' for Leg of 
Route

Touch to Adjust 
Time/Fuel on Board



FltPlan Go for Android User's Guide190-02961-00 Rev A 81

NavLogs

FltPlan 
A

ccount
A

irports
M

aps
N

avLogs
External

Checklists
Binders

W
eather

Flight 
Tracking

Tools
Scratch 

Pad
Dow

nloads
Settings

Index

MY NAVLOGS/WX

Touch the button at the top, center, with the Departure and Arrival airport ID's, e.g.  to display a menu listing 
My NavLogs/Wx.

Touch the desired NavLog to download to the device. 

Touch the refresh arrow to refresh the downloaded NavLogs.

FltPlan Go - NavLogs Page - My NavLogs / WX

Touch to Refresh All NavLogs

Touch to Refresh NavLog

Touch to Download NavLog to Device

NavLogs Saved to Device for Offline Use

NavLogs Available Only While Online

SYNCING NAVLOGS

When a flight plan is created in FltPlan.com, the flight information, including NavLogs, Routes, Weight & Balance 
Calculations, and Checklists, are synced to the FltPlan Go program.

	
NOTE: After creating a flight plan on FltPlan.com and generating a NavLog, the User needs to touch the Save button, which will 
allow the FltPlan Go program to import the NavLog and save for offline viewing. 
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NAVLOG INFORMATION
Once a route has been crated in the FlPlan.com page, touch Press Here for NavLog to view a long list of pertinent information 

for the flight, such as Navigation Log, Trip Notes, Winds Matrix, Weather Info, and Airport Diagrams for the Departure and 
Arrival Airports.

NAVIGATION LOG DETAILS

The Navigation Log includes the following information:

1 Aircraft registration (N#).

2 Departure Airport International Civil Aviation Organization (ICAO) Identifier. 

3 Departure Time (Zulu).

4 Destination Airport International Civil Aviation Organization (ICAO) Identifier.

5 ICAO Aircraft Equipment Information.

6 Fuel On Board (HHMM), Souls On Board, Pilot In Command, and Second In Command (if necessary). 

7 Fixes / Waypoints Filed for the Route.

8 Estimated Time Enroute (HH:MM).

9 Alternate Airport International Civil Aviation Organization (ICAO) Identifier.

10 Planned Flight Level / Altitude.

11 Planned maximum runway takeoff weight (10,400 lbs.).

12 ICAO Aircraft Equipment Information.

13  Aircraft Type Identifier and Equipment Suffix.

14  Type of Operation (General Aviation).

15 Flight Plan Rules for Route (IFR / VFR).

1

2

3

4

5

6

7

8

9

10

11

12

131415
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WINDS ALOFT MATRIX

The Winds Aloft Matrix is the next section and includes the following information:

1 Departure and Arrival Airport International Civil Aviation Organization (ICAO) Identifier.

2 Flight Level / Altitude, i.e. FL410 = 41,000' MSL.

3 Fix / Waypoint Along Route.

4 Bearing To / From the Fix / Waypoint.

5 Average Tailwind Component (Knots) for Trip.

6 Flight Time (HH:MM) and Time Difference Between the Next Altitude Data Set. 

7 Amount of Fuel Used (lbs or gals). 

8 Average True Airspeed (Knots) for Trip.

9 Temperature (°C). 

10 Wind Velocity (Knots).

11 The Difference (%) Bewteen the Route via Airways vs. Direct. 

12 Distance of the Planned Route via Airways (Nautical Miles).

13 Distance of the Direct Route (Nautical Miles).

14 Magnetic Course.

15 True Course.

1

2

3

4

5

6 7 8

9

10

1112131415
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FIX INFO

The Fix Info is the next section and includes the following information:

1 Departure Airport International Civil Aviation Organization (ICAO) Identifier.

2 Frequency for Navigational Aid.

3 Destination Airport International Civil Aviation Organization (ICAO) Identifier.

4 State Abbreviation.

5 Latitude (°N/°S) and Longitude (°W/°E).

6 Magnetic Course Approaching Fix and Magnetic Course Leaving Fix. 

7 Length of Leg (Nautical Miles). 

8 Distance Remaining to Primary Destintation (Nautical Miles). 

9 Fuel Consumption for the Leg (lbs or gals). 

10 Total Fuel Consumption for the Trip (lbs or gals).

11 Estimated Time for the Leg (HH:MM). 

12 Estimated Time Remaining Until Primary Destination (HH:MM).

13 Estimated Time Enroute Until Primary Destination (HH:MM).

14 Frequency for Weather Information.

1

2

3

4 5 6 7 8 9 10 11 12 13

14
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FUEL BURN & ALTERNATE AIRPORT INFO

The Fuel Burn & Alternate Destination Airport is the next section and includes the following information:

1 Alternate Airport International Civil Aviation Organization (ICAO) Identifier, Name, and Location (City, State).

2 Primary Destination Airport Name and CTAF/UNICOM Frequency.

3 Primary Destination Airport Phone Number.

4 Fuel Burn for Taxi (lbs or gals).

5 Total Fuel Burn for Trip (lbs or gals).

6 Fuel Burn to Fly to Alternate Airport (lbs or gals). 

7 Fuel Needed to Fly for 45 Minutes Upon Reaching Alternate Airport (lbs or gals).

8 Phone Number for Flight Service Station.

9 Minimum Amount of Fuel Needed for Trip (lbs or gals). 

10 Fuel Burn to Fly to Alternate Airport (lbs or gals). 

11 Hourly Fuel Calculation (lbs or gals). 

12 Time Needed to Fly From Primary Destination Airport to the Alternate Airport (HH:MM).

13 Distance Needed to Fly From Primary Destination Airport to the Alternate Airport (Nautical Miles).

14 Bearing From the Primary Destination Airport to the Alternate Airport.

15 Altitude Used to Calculate Flight Data From The Primary Destination Airport to the Alternate Airport.

16 Common Traffic Advisory Frequency (CTAF) for the Primary Destination Airport.

17 Automated Weather Observing Station (AWOS) for the Primary Destination Airport.

18 Elevation for the Primary Destination Airport (ft).

1

3 5 7 8 9

10

11121314

2

4 6

15161718



FltPlan Go for Android User's Guide190-02961-00 Rev A 86

NavLogs

Fl
tP

la
n 

A
cc

ou
nt

A
irp

or
ts

M
ap

s
N

av
Lo

gs
Ex

te
rn

al
Ch

ec
kl

ist
s

Bi
nd

er
s

W
ea

th
er

Fl
ig

ht
 

Tr
ac

ki
ng

To
ol

s
Sc

ra
tc

h 
Pa

d
Do

w
nl

oa
ds

Se
tti

ng
s

In
de

x

AIRPORT DIAGRAMS

The next section in the Navigation Log is Airport Diagrams, which displays the Departure and Arrival Airport Diagrams, 
and, if available, FBO location. 

	
NOTE: Airport Diagrams could be out of date, please verify with the apporpriate source for any changes/updates. 

FltPlan Go - NavLogs Page - Airport Diagrams

FBO Location 
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WINDS MATRIX - EXPANDED

The next section in the Navigation Log is the Winds Matrix, but with greater detail than previously listed in the Navigation 
Log. The vast majority of information is the same, but more details are listed for fuel burn and time per Fix. Additional Cruise 
Altitude information is also detailed, allowing the User to view more data pertinent to the Trip. The filed altitude for the Trip 
will be highlighted with a green background.

	
NOTE: When a Cruise Altitude exceedes the aircraft limitiations, ABOVE MAX ALT will be displayed and the various data points will 
remain blank.

FltPlan Go - NavLogs Page - Winds Matrix - Expanded

Filed AltitudeAltitude 
Exceedes 
Aircraft 

Limitations
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RUNWAY & APPROACH INFO

The next section in the Navigation Log is the Runway and Approach info, where both the Departure Airport and Arrival 
Airport will have runway (length, width, usable, etc.) and approach info (eqiupment, inbound course, frequency, etc.) 
displayed. 

1 Departure Airport International Civil Aviation Organization (ICAO) Identifier.

2 Runway Length (ft) x Width (ft). 

3 Runway I.D. 

4 Type of Approach/Equipment. 

5 Total Usable Runway (ft).

6 ILS Navigation Frequency.

7 Inbound Course.

8 Arrival Airport Elevation (ft).

9 Arrival Airport International Civil Aviation Organiztion (ICAO) Identifier. 

10 Departure Airport Elevation (ft). 

1

3

5 7

8910

2

4 6
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The remaining sections within the Navigation Log contain the following raw data/text sets:

	� Departure Airport METARs

	� Departure Airport Forecast

	� Recent NOTAMs - Departure Airport (New or Modified)

	� Departure Airport NOTAMs

	� Nearby Departure Airport METARs

	� Arrival Airport METARs

	� Arrival Airport Forecast

	� Recent NOTAMs - Arrival Airport (New or Modified)

	� Arrival Airport NOTAMs

	� Alternate Airport METAR/TAF

	� Recent NOTAMs - Alternate Airport (New or Modified)

	� Alternate Airport NOTAMs

	� Nearby Arrival Airport Weather

	� Enroute METARs and TAFs

	� Enroute Navigation NOTAMs

	� Enroute PIREPs

AUTO SYNCING NAVLOGS
When the User creates a flight plan on FltPlan.com, flight information including NavLogs, Routes, Weight & Balance 

Calculations, and Checklists are auto-synced to the FltPlan Go program. When auto-sync is enabled, push notifications will 
be received (pop-up) directly to the device anytime a new NavLog is available. When a flight is approaching, FltPlan Go will 
automatically send a push notification with the latest NavLog information one hour prior to departure.

FltPlan Go - NavLogs Push Notification
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EMAIL/SHARE

Touch  within the Airports section to display a menu listing available sharing and/or storage options (e.g.  Chrome, 
Nearby Share, Drive, Quick Share, Gmail, etc.).

Touch to Save to Recent Location

Touch to View/Adjust 
Device Visibility

FltPlan Go - NavLogs - Share/Save Menu

Touch to Select Sharing Method

Touch to View Additional Options

ACCOUNT

Touch the button in the top right corner, e.g.  to Add Account or Logout.
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EXTERNAL 
The External icon is fifth on the Home Menu. On the External Devices section, the User can view several device categories, 

such as Internal, External, and Simulators. 

FltPlan Go - External Page

Touch to View

Current Selection

Connection 
Status/Info

Touch to 
Disable GPS

Touch to Select
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INTERNAL DEVICES
Touch the device under the Internal heading, e.g. Android GPS, to view information gathered by the Android's internal GPS, 

such as:

	� Status

	� Accuracy (meters)

	� Latitude

	� Longitude

	� Altitude (ft)

	� Course

	� Speed (knots)

	� Last Update 

The Android's internal GPS is automatically enabled by default. To disable, touch the Disable GPS button.

EXTERNAL DEVICES
The next section is External, which lists devices compatible with the FltPlan Go program.

	
NOTE: The desired External device must be connected to the Android via Settings. Once the connection has been established, the 
device will be visible for the User to select within the list of External devices. For an updated list of compatible devices, please click 
on the following link: https://www.fltplan.com/FltPlanConnectivityOptions.pdf

	
NOTE: When a connection is made with a Stratus 3, it will automatically switch to GDL90 Mode to work with FltPlan Go. 

	
NOTE: To connect an ADS-B device, ensure the Android is connected to the unit via Bluetooth or Wi-Fi. Once connected, touch the 
External tab and select the unit within the list of External devices. 

	
NOTE: If the Android disconnects from the ADS-B unit, FltPlan Go will automatically reconnect to the last unit used. 

Connecting to External GPS Unit:

1)	 Ensure the most recent version of FltPlan Go is downloaded.

2)	 Connect the External GPS to the device via Wi-Fi or Bluetooth.

3)	 Ensure Location Services is enabled for FltPlan Go in the Android's Settings. 

4)	 Open FltPlan Go.

5)	 Touch the External Tab and verify the Internal GPS is enabled. Please wait for the Latitude and Longitude to populate.

6)	 Touch Maps > Options > Display Ship Position. 

https://www.fltplan.com/FltPlanConnectivityOptions.pdf
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Connecting to ADS-B Unit:

1)	 Ensure the most recent version of FltPlan Go is downloaded.

2)	 Connect the ADS-B unit to the device via Wi-Fi or Bluetooth.

3)	 Open FltPlan Go.

4)	 Touch the External Tab.

5)	 Select the desired ADS-B unit and wait for the 'Connected' message to appear in the top right corner.

6)	 Once connected, touch the Maps Tab.

7)	 Touch ADS-B in the top right corner, then select the desired information to display on the Map.

	
NOTE: When located in a high traffic area, disabling the 'yellow' aircraft (the furthest away) may help declutter the Map by display-
ing only the 'orange' and 'red' aircraft, which are closer.

SIMULATORS
The next section is Simulators, which lists the devices compatible with the FltPlan Go program.

	
NOTE: To connect a Simulator, ensure the system is turned on, touch the External tab, and select the unit within the list of Simula-
tors.

	
NOTE: Only one (1) X-Plane user is allowed per network.

Connecting to X-Plane:

1)	 Ensure the most recent version of FltPlan Go is downloaded.

2)	 Ensure the latest version of X-Plane is installed.

3)	 Ensure the device running FltPlan Go and the computer running X-Plane are on the same wireless network. 

4)	 Open X-Plane on the computer.

5)	 Load a flight.

6)	 Touch Settings > Net Connections > Android/Device. Verify all options are toggled 'On'.

7)	 Use the default port and leave the IP field empty.

8)	 Close the Settings Menu.

9)	 Open FltPlan Go app on the device.

10)	 Touch External Tab > X-Plane (under Simulators). Wait until status reads 'Connected'.

11)	 Touch Maps Tab > Options > Display Ship Position > Toggle Breadcrumbs.

The connections should now be set, allowing the User to start the flight on X-Plane while viewing the position in the FltPlan 
Go program.
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Connecting to Flight Simulator X or Prepare3D:

	
NOTE: A connection will be evident when messages are being sent.

1)	 Ensure the most recent version of FltPlan Go is downloaded.

2)	 Ensure the latest Service Pack is installed.

3)	 Go to www.fltplan.com/fsx.htm to download the FltPlan Go GPS file on the computer that will be used with FSX or Prepar3D.

4)	 Once the FltPlan Go GPS file downloads, extract FSX.zip, then run 'setup.exe' and follow the on-screen instructions.

5)	 For Steam users, locate the extracted FSX.zip file and click on Steam SDK > SimConnect.msi, then run SimConnect.msi and 
follow the on-screen instructions.

6)	 Open FSX or Prepar3D and enter the flight information.

7)	 Prior to starting the flight in FSX or Prepar3D, open the FltPlan Go GPS file > Connect to FSX, then wait for a connection.

8)	 Open FltPlan Go app on the device.

9)	 Touch External Tab > FSX & Prepar3D (under Simulators). Wait until status reads 'Connected'.

10)	 Touch Maps Tab > Options > Display Ship Position > Toggle Breadcrumbs.

The connections should now be set, allowing the User to start the flight on FSX or Prepar3D while viewing the position in 
the FltPlan Go program.

http://www.fltplan.com/fsx.htm
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CHECKLISTS 
The Checklist icon is sixth on the Home Menu. Any checklists associated with the account, e.g. Garmin, will be listed with  

above the aircraft. Touch  to view all applicable checklists for that aircraft. 

FltPlan Go - Checklists Page

Touch to View

Touch to Refresh

Touch to View 
Checklists

CHECKLIST FOR AIRCRAFT
After selecting the desired aircraft, all applicable checklists will be listed. Touch the desired aircraft checklist, e.g. 'Exterior - 

Cockpit - Cabin Checks'. At the top of the screen, touch < to navigate to a previously viewed checklist or touch > to navigate 
to the next checklist in sequence.

CHECKING OFF ITEMS
The first checklist item to complete will be listed at the top, with the action listed below, e.g. 'Aircraft Documents (Item) 

Aboard (Action).

Touch Done beneath the action when the item has been completed. A  will be displayed to indicate the checklist item 
has been successfully completed.

SKIPPING ITEMS

Touch  to skip a checklist item. A  will be displayed to indicate the checklist item has been skipped. Continue 
throught the remainder of the checklist as necessary, then, when reaching the end, any skipped items will prompt a pop-up 
window stating "Checklist has a skipped item. Move to skipped item?". Touch Cancel to continue without completing the 
skipped checklist item, or touch Yes to move to the missed checklist item. Once all checklist items are completed, a pop-up 
window will appear stating "Checklist completed. Proceed to next checklist?".  Touch Cancel to close the pop-up window and 
remain on the current checklist. Touch Continue to proceed to the next checklist in sequence.
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TEXT TO SPEECH
Touch the button next to 'Text 2 Speech' to toggle On/Off, as desired. When enabled, the green circle will be visible, which 

allows the feature to audibly read the two lables (Item and Action) for any checklist item. 

	
NOTE: Please ensure the volume is at an adequate level on the device to properly use the Text 2 Speech feature.

RESET LIST

Touch the Reset List button to restore all the checklist items to the deafult 'unselected' status.

FltPlan Go - Checklists - Skipped Item

Touch to View 
Next Checklist

Touch to View 
Previous Checklist

Touch to Reset All 
Aircraft Checklists

Checklist Item

Checklist Action

Touch When 
Completed Touch to Skip Item

Touch to Reset List

Successfully 
Completed 
Checklist Item

Skipped Checklist 
Item

Scroll to View 
Additional Items

Touch to Toggle 
On/Off
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CREATING CHECKLIST ON FLTPLAN.COM

	
NOTE: The User can only create or edit a checklist from either the FltPlan.com Tab in FltPlan Go, or on the FltPlan.com website.

Log Into FltPlan.com: When connected to the internet, log into FltPlan.com with a username and password.

FltPlan.com - Home - Tools

Click to View

Click to Expand/Collapse
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Viewing Checklist Tutorial:

1)	 From the Main Menu, click Tools > Checklist.

2)	 Click Tutorial to view a Checklist Tutorial pdf. in a separate browser window. 

FltPlan.com - Tools - Checklist Selection

Click to View 

Click to Add Checklist

Click to View Checklist

Click to Edit Checklist

Adding Checklist:

1)	 From the Main Menu, click Tools > Checklist.

2)	 Click Add next to the desired Checklist, e.g. N2345B. 

3)	 Select the Aircraft Category, Single Engine Piston, Multi Engine Piston, Turbo Prop, Jet, or Helicopter.

4)	 Select the Manufacturer's Checklist or User Created Checklist, as desired. 

5)	 The User will be redirected to the Checklist Selction page. Click View next to the desired Checklist.

Select Aircraft 
Category

FltPlan.com - Tools - Add Checklist Category

Enter Info
Click to 
Copy Profile
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FltPlan.com - Tools - Jet Checklists

Click to Create Checklist

Select 
Manufacturer's 

Checklist

Select User 
Checklist



FltPlan Go for Android User's Guide190-02961-00 Rev A 100

Checklist

Fl
tP

la
n 

A
cc

ou
nt

A
irp

or
ts

M
ap

s
N

av
Lo

gs
Ex

te
rn

al
Ch

ec
kl

ist
s

Bi
nd

er
s

W
ea

th
er

Fl
ig

ht
 

Tr
ac

ki
ng

To
ol

s
Sc

ra
tc

h 
Pa

d
Do

w
nl

oa
ds

Se
tti

ng
s

In
de

x

Adding Custom Checklist:

1)	 From the Main Menu, click Tools > Checklist.

2)	 Click Add next to the desired Checklist, e.g. N2345B. 

3)	 Select the Aircraft Category, Single Engine Piston, Multi Engine Piston, Turbo Prop, Jet, or Helicopter.

4)	 Click Create Custom Checklist. 

5)	 Click Add New Category in the Standard Checklist window, or the Emergency Checklist window. 

FltPlan.com - Checklists - Custom - Standard

Click to Add Standard 
Checklist Category

6)	 Enter a Category Name, then click Save Category. The Category Name will now be listed, e.g. 'Checklist TEST'.

FltPlan.com - Checklists - Custom - Standard - Add New Category

Click to Enter Info

Click to Save

7)	 Click Add New Item. 
Checklist Name Click to EditClick to Sort

FltPlan.com - Checklists - Custom - Standard - Add New Item
Click to Add Click to Print

8)	 Enter a title for the checklist Item, e.g. 'Cabin Preparation'.

9)	 Enter a description for the checklist Action, e.g. 'Vacuum and clean cabn'.
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10)	 Click Add Item/Action.

FltPlan.com - Checklists - Custom - Standard - Add New Item - Details
Click to Add 

Click to Enter Info

11)	 The User will be redirected to the Custom Checklist with the new Item/Action displayed. To add a new Item/Action, click Add 
New Item. 

12)	 Click Edit next to the Item/Action and/or the Checklist Title to adjust, as desired.

FltPlan.com - Checklists - Custom - Standard - New Item Added
Click to PrintClick to Add Click to Edit

Click to Edit

13)	 Click Sort Checklist, then adjust the order by clicking  or . 

14)	 Once the Checklist has been sorted, click Checklist Display to save. 

FltPlan.com - Checklists - Custom - Standard - Sort Checklist
Click to View

Click to Move Down

Click to Move Up

15)	 When the Custom Checklist is complete, click Print Checklist to display the checklist in 'Printer Friendly' format in another 
browser window.

16)	 Click Checklist Menu to return to the Main Checklist Page. The Custom Checklist is now able to sync with FltPlan Go.

17)	 To view the new Checklist in FltPlan Go, launch the FltPlan Go app, then touch Checklist > Refresh.
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Edit Checklist:

1)	 From the Main Menu, click Tools > Checklist.

2)	 Click Edit next to the desired checklist, e.g. N2345B. 

3)	 Click  to display Edit Options.

FltPlan.com - Checklists - Edit or Delete

Click to Edit Click to Delete

4)	 Click Add New Category in the Standard Checklist window, or the Emergency Checklist window. 

5)	 Enter a Category Name, then click Save Category.

6)	 Click Sort Categories, then adjust the order by clicking  or .

7)	 Click Select next to the desired checklist item and edit/adjust information, e.g. 'Before Start'.
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FltPlan.com - Checklists - Edit

Click to Edit
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8)	 Click Edit next to the desired checklist item and edit/adjust informatoin, e.g. 'I Pads / Hot Spot'.

FltPlan.com - Checklists - Edit - Before Start

Click to Edit

9)	 Click Save Item/Action, or Delete Item/Action, as desired. The updated Item/Action will now be included in the checklist.

FltPlan.com - Checklists - Edit - Before Start - iPads

Click to Edit Info

Click to Save Click to Delete
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10)	 Click Checklist Menu to return to the Main Checklist Page. The edited Checklist is now able to sync with FltPlan Go.

11)	 To view the newly modified Checklist in FltPlan Go, launch the FltPlan Go app, then touch Checklist > Refresh.

FltPlan.com - Checklists - Edit - Before Start - iPads - Edited
Updated Action

Delete Checklist:

1)	 From the Main Menu, click Tools > Checklist.

2)	 Click Edit next to the desired checklist, e.g. N2345B. 

3)	 Click  to Delete the checklist.

4)	 There will be a prompt to confirm, click OK to delete the checklist, or Cancel to exit without deleting.
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BINDERS 
The Binders icon is seventh on the Home Menu. Here the User can create flight specific binders with customized information 

related to many things, including documents, procedures, airports, NavLogs, and weather. 

ADDING NEW BINDER
In the top left corner of the Binders Header Menu, touch the New Binder button to manually Set Binder Name. 

FltPlan GO - Binders

Touch to View/Edit

Touch to Add Binder

Touch to View

Longpress to Delete

Touch Done to Save, or Cancel to exit without saving. 

FltPlan GO - Binders - New Binder - Set Binder Name

Touch to Enter Binder Name

Touch to Save

Touch to Cancel
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EDIT BINDERS

RENAMING OR DELETING BINDERS
Longpress on the desired binder to display a pop-up window with two options, 'Delete' or Rename. Touch Delete to remove 

the binder or touch Rename to manually enter text and rename the binder. Touch Cancel to exit without saving.

FltPlan GO - Binders - Edit Binders - Delete or Rename

Touch to Cancel

Touch to Delete Binder

Binder Name

Touch to Rename Binder

ADDING TO BINDERS
Touch the desired binder to view available files, then touch  to 'Add New' and display a 'Choose an Item' menu, which 

lists:

	� Add Procedure

	� Add Airport

	� Add A/FD

	� Add Documents

	� Add NavLog

	� Add Weather Brief

	� Add FltTrack Tail Number

	� Add ScratchPad Sketch

FltPlan GO - Binders - Add New - Choose an Item Menu

Touch to View/Add to Binder
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Add Procedure:

1)	 From the Binders Page, touch the desired Binder >  > Add Procedure. The 'Search Airports' menu is now displayed.

2)	 Towards the bottom of the 'Search Airports' menu, select the desired region, either U.S., Canada, or Other.

3)	 Enter the ICAO airport I.D., e.g. KFOE and select the desired airport from the list. The 'KFOE' Procedures menu is now displayed.

4)	 Select the desired procedure to add to the binder. Repeat as necessary to load additional procedures into the binder.

Add Airport:

1)	 From the Binders Page, touch the desired Binder >  > Add Airport. The 'Search Airports' menu is now displayed.

2)	 Towards the bottom of the 'Search Airports' menu, select the desired region, either U.S., Canada, or Other.

3)	 Enter the ICAO airport I.D., e.g. KFOE and select the desired airport from the list to add all Airport Info into the binder. Repeat as 
necessary to load additional Airports into the binder. 

Add A/FD:

1)	 From the Binders Page, touch the desired Binder >  > Add A/FD. The 'Search Airports' menu is now displayed.

2)	 Towards the bottom of the 'Search Airports' menu, select the desired region, either U.S., Canada, or Other.

3)	 Enter the ICAO airport I.D., e.g. KFOE and select the desired airport from the list to add A/FD into the binder. Repeat as necessary 
to load additional A/FDs into the binder.

Add Documents:

1)	 From the Binders Page, touch the desired Binder >  > Add Documents. The 'Choose a Document' menu is now displayed.

2)	 Select the desired document from the list, e.g. 'FltPlan Go Android Users Manual', to add to the binder. Repeat as necessary to 
load additional documents into the binder.

Add NavLogs:

1)	 From the Binders Page, touch the desired Binder >  > Add NavLog. The 'NavLogs / WX' menu is now displayed.

2)	 Select the desired NavLog to add to the binder. Repeat as necessary to load additional NavLogs into the binder.

Add Weather Brief:

1)	 From the Binders Page, touch the desired Binder >  > Add Weather Brief. The 'Weather' menu is now displayed.

2)	 Enter the ICAO airport I.D., e.g. KFOE into the Location text box.

3)	 Touch Get WX to populate the most recent weather data and add to the binder. Repeat as necessary to load additional Weather 
Briefs into the binder.

Or:

4)	 Select the ICAO airport I.D. from the 'Saved Weather Briefs' section to add to the binder. Repeat as necessary to load additional 
Weather Briefs into the binder.
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Add FltTrack Tail Number:

	
NOTE: Some aircraft, such as military, are not available for tracking by the general public.

1)	 From the Binders Page, touch the desired Binder >  > Add FltTrack Tail Number. The 'Tracking' menu is now displayed.

2)	 Enter the aircraft tailnumber, e.g. N2345B, into the Tail Number text box.

3)	 Touch Get Tracking to add the aircraft tracking file to the binder. Repeat as necessary to load additional aircraft tracking files 
into the binder.

Or:

4)	 Select the desired aircraft tail number from the 'Saved Tracking Files' section. Repeat as necessary to load additional aircraft 
tracking files into the binder.

Add ScracthPad Sketch:

1)	 From the Binders Page, touch the desired Binder >  > Add ScratchPad Sketch. The 'Select File' menu is now displayed.

2)	 Select the desired ScratchPad file to add to the binder. Repeat as necessary to load additional ScratchPad files into the binder. 

MY DOCUMENTS
Within the Binders Page, touch the My Documents binder to view saved documents associated with the account. 

	
NOTE: To delete or download Documents, please go the the Downloads Tab. Once the files are successfully downloaded, they will 
appear in the Documents binder.

FltPlan GO - Binders - My Documents

Touch to View

Touch to Add File

Touch to Download

Successfully 
Downloaded

Touch to Filter

Touch to 
Refresh List
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ADD FILE TO MY DOCUMENTS
Touch Binders > My Documents > Add File to display the 'Add File' menu. Select the desired file to add to the binder.

FltPlan GO - Binders - My Documents - Add File Menu

Touch to View Previous Storage Location Touch to View Next Storage Location

Touch to View

Touch to Cancel

FltPlan GO - Binders - My Documents - Add File Menu - FltPlan Mobile

Touch to View Previous Storage Location Touch to View Next Storage Location

Touch to View

Scroll to View Additional Info
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FILTER MY DOCUMENTS

Touch Binders > My Documents >  to display the 'Filter Documents' menu listing the following display options: All, 
Downloaded, Not Downloaded, and Update Available.The default My Documents Filter setting is 'All'. Select the desired Filter 
display options to adjust the display. 

FltPlan GO - Binders - My Documents - Filter Menu

Touch to Select

VIEWING BINDER FILES
After a binder has been selected, a list of applicable files will be visible in thumbnail format. Touch the desired thumbnail 

to view the file in full-screen mode. 

	
NOTE: A connection to Wi-Fi or cellular network must be established to ensure current chart/procedure information.

UPLOADING FILES TO FLTPLAN GO
Uploading files, such as a pdf, to FltPlan Go, can be accomplished only if the files were loaded to the same FltPlan.com 

account. 

Uploading PDF to FltPlan Go:

1)	 In the FltPlan Go program, touch Downloads > Documents. 

2)	 Any documents uploaded via FltPlan.com will be visible. Touch the desired document to upload to the device. 

3)	 Once the file is successfully uploaded, touch Binders > My Binders, then select the desired document to view. 

4)	 Touch the Add button in the top right corner > Add Documents.

5)	 Select the PDFs uploaded from FltPlan.com, then touch the desired files to save to the Binder.

	
NOTE: Once downloaded, Procedures, Airports, A/FDs, Documents, NavLogs, and ScratchPad documents can be viewed offline. 
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WEATHER 
The Weather icon is eighth on the Home Menu, and displays the Weather Page, which includes the following items:

	� Departure / Arrival Airport METARs, Forecast, and NOTAMS

	� Nearby Airport Departure / Arrival NOTAMs

	� Nearby Departure / Arrival Airport Weather

	� Enroute PIREPs, METARs, and TAFs.

The Banner Menu within the Weather section contains two buttons,  and My Airports / Routes. 

FltPlan GO - Weather

Touch to View

Touch to Re-
fresh Data

Touch to View My 
Airports/Routes

Touch to Print

Touch to View

Touch to 
Expand/Collapse

Weather Data 
Timestamp
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FltPlan GO - Weather - METAR Legend

REFRESH DATA

	
NOTE: In order to view the latest Weather, update a document, or use FltTracking, a Wi-Fi or cellular network connection must be 
established.

Located in the upper left corner of the Weather Page,  allows the User to import data frequently to ensure accurate 

information prior to departure. Each time  is selected, a timestamp entitled Certified Weather towards the top of the page 
will update with the UTC request time (MM/DD/YYYY & Zulu Time).

MY AIRPORTS / ROUTES
Located in the middle of the Banner Menu within the Weather section, the My Airports / Routes button allows the User to 

Edit or Add information. 

FltPlan GO - Weather - Banner Menu

Touch to View My Airports/RoutesTouch to Refresh Data

Adding Location:

1)	 Touch the My Routes button, e.g.  > Show Location Weather.

2)	 Enter the Airport ID (ICAO), e.g. KLWC in the Location text box.

3)	 Touch Get WX to save and continue.

Or	 Touch Close to exit without saving. 



FltPlan Go for Android User's Guide190-02961-00 Rev A 114

Weather

Fl
tP

la
n 

A
cc

ou
nt

A
irp

or
ts

M
ap

s
N

av
Lo

gs
Ex

te
rn

al
Ch

ec
kl

ist
s

Bi
nd

er
s

W
ea

th
er

Fl
ig

ht
 

Tr
ac

ki
ng

To
ol

s
Sc

ra
tc

h 
Pa

d
Do

w
nl

oa
ds

Se
tti

ng
s

In
de

x

Adding Route:

1)	 Touch the My Routes button, e.g.  > Show Route Weather.

2)	 Enter an Airport ID (ICAO), e.g. KLWC in the Dept (Departure) text box and the Arrv (Arrival) text box.

3)	 Touch Get WX to save and continue.

Or	 Touch Close to exit without saving.

FltPlan GO - Binders - My Documents - Filter Menu

Touch to Toggle Between Route 
& Location Weather Options

Touch to Enter Info

Touch to Close Touch to Load Weather Data

Touch to View
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FLIGHT TRACKING 
The Tracking icon is ninth on the Home Menu, and displays the available aircraft ID's the User set-up for flight tracking via 

FltPlan.com. The Banner Menu within the Tracking section contains two buttons, , and My Aircraft (or the most recently 
viewed aircraft ID, (e.g.N861PP).

FltPlan GO - Tracking - Main

Touch to Re-
fresh Data

Touch to View 
My Aircraft

Scroll to View 
Additional Info

Touch to View 
on Map

Scroll to View 
Additional Info

Touch to Re-
fresh Data

 

REFRESH DATA
There are two ways to refresh tracking data once an aircraft has been selected within the Tracking section. The User can touch 

 in the upper left corner, or  located on the right hand side to refresh data. A timestamp is created and displayed on the 
right hand side in the following format: MM/DD/YYYY and HH:MM (Zulu). 

MY AIRCRAFT
The second button on the Banner Menu is My Aircraft. Touch this button and a drop-down menu will appear, listing available 

aircraft. 

FltPlan GO - Tracking - My Aircraft

Touch to Enter Info

Touch to Add & Track Aircraft 

Touch to Select

Touch to Exit
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NOTE: If the 'My Aircraft' list is empty/blank, or if an 'Error' is noted, the applicable account does not have any tracking services 
set-up via FltPlan.com. To add aircraft tracking services, touch FltPlan.com > Flight Tracking  > Flight Tracking and enter the 
desired aircraft I.D. and email address for notifications. 

	
NOTE: Some aircraft, such as military, are not available for tracking by the general public.

FltPlan.com - Tracking - Aircraft - Notifications

Touch to 
Expand/Collapse

Scroll to View 
Additional Info

Touch to 
View/Select

Touch to Send 
Test Email

Touch to Enter/
Change Email

Touch to Toggle 
'On/Off'

Touch to Save

FLIGHT TRACKING MAP
After an aircraft has been added, touch My Aircraft to view the drop-down menu, then select the desired Aircraft ID from the 

list to display the Flight Tracking Map. The User can now view additional details regarding specific flights per aircraft, which 
includes the following information: 

	� Flight Number (if applicaable)

	� Departure Airport

	� Departure Time

	� Arrival Airport

	� Estimated Arrival Time

	� Time to Arrival

	� Status

	� Altitude (ft)

	� Ground Speed (knots)

	� Equipment

SWITCHING AIRCRAFT
While viewing the flight tracking map, the User can switch the aircraft by touching the My Aircraft button in the top, center 

of the page. Select the desired Aircraft ID to switch and view flight tracking information.
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MAP OPTIONS
While viewing the flight tracking map, the User can toggle various menu's to adjust the data displayed, a vertical Flight 

Tracking menu, and a horizontal Map Options display menu.

FltPlan GO - Tracking - Flight Details

Touch to View 
My Aircraft

Touch to Re-
fresh Data

Touch to Enter & 
Search Aircraft ID

Touch to Hide/
View Menu

Touch to View

Touch to 
Toggle On/Off

Touch to Expand/
Collapse

Touch to View 
Map Options

Touch to View 
Legend

Touch to View Info
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FLIGHT TRACKING MENU

The first menu is the vertical display on the lefthand side, which lists the following information:

	� Aircraft ID and status (e.g. Landed).

	� Departure & Arrival Airport

	� Depart Time & Arrive Time Actual

	� Flight Time

	� Aircraft Model (e.g. C172) & Type.

	� Filed & Amended Route.

	� Flight Tracking Status. If an aircraft is not being tracked, 'Not Following Airplane' will be displayed with a red background. 
If an aircraft is being tracked, 'Following Airplane' will be displayed with a green background.

FltPlan GO - Tracking - Flight Details - Map Legend

MAP OPTIONS MENU

While viewing the flight tracking map, touch Map Options towards the top of the screen, below the Banner Menu, to view 
the following display settings:

	� Display Airports

	� Light/Dark Map

	� Display Routes (None, Airborne, or All) 

	� Display Day/Night 

Adjust the settings as desired, then touch the dark blue FltPlan.com banner to close the Map Options menu.

FltPlan GO - Tracking - Flight Details - Map Options Banner Menu
Touch to Expand/Collapse

Touch to Adjust

Touch to Expand/
Collapse Menu

Touch to Toggle On/Off



FltPlan Go for Android User's Guide190-02961-00 Rev A 119

Tools

FltPlan 
A

ccount
A

irports
M

aps
N

avLogs
External

Checklists
Binders

W
eather

Flight 
Tracking

Tools
Scratch 

Pad
Dow

nloads
Settings

Index

TOOLS 

TOOLS
The Tools icon is tenth on the Home Menu, and displays two groups of icons, Tools & Calculators. The Tools group consists 

of the following items:

	� PDC Service

	� Cloud Tops

	� Weight & Balance (W & B)

	� eLogBook

	� Contacts

FltPlan GO - Tools - Main

Touch to View
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The Calculators group consists of the following items:

	� Numeric

	� C° <-> F° 

	� Temperature

	� Density Altitude

	� Winds

	� Airport Winds

	� Conversions

	� Equal Time

PRE-DEPARTURE CLEARANCE (PDC) SERVICE

From the Tools Tab, touch  to view the PDC Service page, where the User can add/view PDC information, such as Tail 
Number, Departure Airport, and Arrival Airport.

FltPlan GO - Tools - Pre-Departure Clearance

Touch to Enter Info

Touch to Save & 
Obtain PDCTouch to Remove All PDCs

Entering PDC Info:

1)	 Touch Tools > . 

2)	 Enter Aircraft Tail Number (e.g. N861PP).

3)	 Enter Departure Airport (ICAO ID).

4)	 Enter Arrival Airport (ICAO ID).

5)	 Touch Get PDC. The PDC will now be listed in the Saved PDCs section.

Deleting PDC:

1)	 Touch Tools > PDC Services.

2)	 Touch the red 'X' listed next to the Saved PDC to Delete.

Or	 Touch the Delete All button to delete all PDCs. 
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ELOGBOOK

From the Tools Tab, touch  to view the eLogbook page, where the User can add/view Logbook entries.

LOG-IN

	
NOTE: First time users must register their pilot license number with the FltPlan.com Logbook by visiting logbook.fltplan.com before 
adding their pilot license number to FltPlan.com. Upon completion, the information will be available in FltPlan Go. 

Logging Into eLogbook:

1)	 Touch Tools > .

2)	 Enter Pilot Name, License (Certificate) Number, and Password.

3)	 Touch Log In to save and contintue.

Entering eLogbook Piloting Info:

1)	 Touch Tools > .

2)	 Complete Log-In process.

3)	 At the top of the page, touch 'General Aviation' (the button will display the most recent selection) to view options, then select 
General Aviation, Corporate, Air Taxi, or Scheduled Air Carrier.

4)	 Touch 'Part 91' (the button will display the most recent selection) to view options, then select Part 91, Part 121, or Part 135.

4)	 Touch 'Pilot' (the button will display the most recent selection) to view options, then select Pilot or Flight Instructor.

6)	 Touch 'PIC' (the button will display the most recent selection) to view options, then select PIC, SIC, Student, or PIC/Student.

7)	 Touch the Log Entry button to save to the eLogbook.

Touch to Enter Info

Touch to Save

FltPlan GO - Tools - eLogbook - Log In

Touch to Log In

Touch to Select Aircraft Profile

Touch to View/Select

logbook:fltplan.com
http://FltPlan.com
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Entering eLogbook Info:

1)	 Touch Tools > .

2)	 Complete Log-In process.

3)	 Touch the Info tab. 

4)	 Touch the Aircraft button to change and/or select aircraft profile.

5)	 Enter the Date (YYYY-MM-DD).

6)	 Enter the Departure Airport (ICAO ID).

7)	 Enter the Arrival Airport (ICAO ID).

8)	 Enter the Aircraft Make & Model.

9)	 Enter the Aircraft Tail Number (ID). 

11)	 Enter the Estimated Time Enroute in the Flight Time data field (HH:MM).

12)	 Touch the Log Entry button to save to the eLogbook.

Touch to Enter Info

FltPlan GO - Tools - eLogbook - Log Entry - Date & Route
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Entering eLogbook Aircraft Category and Class Info:

1)	 Touch Tools > .

2)	 Complete Log-In process.

3)	 Scroll down to the Aircraft Category and Class section.

4)	 Touch the desired info, e.g. ASEL (Airplane Single Engine Land), High Performance, Aircraft less than 12,500 lbs.

5)	 Touch the Log Entry button to save to the eLogbook.

FltPlan GO - Tools - eLogbook - Log Entry - Aircraft Category & Class

Touch to Select
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Entering eLogbook Conditions Info:

1)	 Touch Tools > .

2)	 Complete Log-In process.

3)	 Scroll to the Conditions section.

4)	 Enter the necessary logbook entry info.

5)	 Touch the Log Entry button to save to the eLogbook.

FltPlan GO - Tools - eLogbook - Log Entry - Conditions

Touch to Enter Info

Touch to Enter Airport I.D.

Touch to Select
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CLOUD TOPS

From the Tools Tab, touch   and the feautre will access the camera on the device, allowing the User to direct the camera 
towards the clouds and gather data visually.

Obtaining Cloud Top Info:

1)	 Touch Tools > .

2)	 Aim the device, e.g. Samsung Galaxy S7 Tab, outside of the aircraft, with the center, green line touching the top of the clouds. 

3)	 When satisfied, touch the Lock button, which prompts the device to take a screenshot. 

4)	 To keep the screenshot, slide the Lock button to the Left or Right to save the screenshot.

Or	 Repeat step 3 until the desired screenshot is captured.

5)	 Set the aircraft altitude by touching Aircraft Altitude, then scrolling until reaching the current altitude. 

6)	 Set the distance (nm) by touching Distance and scrolling until reaching the current distance from the cloud tops.

No need to adjust the angle, it is automatically determined by the device camera. On the top of the screen, the center number 
displays the cloud height above Mean Sea Level (ft). The smaller numbers located above and below the MSL cloud height 
represent a margin of error of 0.1° in either direction.The number to the right of center displays the height of the clouds relative 
to the current aircraft location (ft). The distances will display green when flying above clouds, red when headed into/below 
clouds, and orange when close to clouds. 

WEIGHT & BALANCE

	
NOTE: Weight & Balance profiles are automatically synced from the User's FltPlan.com account. To add or edit an aircraft W&B 
profile, please go to FltPlan.com. All W&B profiles will automatically download the first time to allow the User to access them offline. 

From the Tools Tab, touch  to view Weight & Balance profiles associated with the active account.Touch the desired 
aircraft icon to view the current W&B set-up, and enter the necessary information.

FltPlan GO - Tools - Weight & Balance - Main

Touch to Change, 
Add, or LogoutTouch to Refresh List

Touch to View/Edit

http://FltPlan.com
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Entering Weight & Balance Info:

1)	 Touch Tools > .

2)	 Touch the desired aircraft icon associated with the aircraft ID (N#).

3)	 Touch the Plane button to view a Top View of the seating and baggage arrangement for the particular aircraft.

4)	 Touch the Legend button to view the Chart Legend.

5)	 Enter info in the Flight Description.

6)	 Enter name of the PIC & SIC.

7)	 Enter the Departure Airport (ICAO ID). 

8)	 Enter the Arrival Airport (ICAO ID).

9)	 Enter Pilot Notes, as desired.

10)	 Enter the number of Passengers.

11)	 Enter the weight of the pilots, passengers, baggage, and fuel capacity, and fuel burn (lbs or gals).

12)	 Toggle the Fuel Units to either Pounds or Gallons., as necessary. 

13)	 Touch the Calculate button at the top to display the Weight, Fwd Limit, C.G., Aft Limit, and % of MAC (if applicable). Scroll 
down to view Max Takeoff Weight (MTOW), the difference between the current weight, and the Zero Fuel Weight. 

	
NOTE: If the current weight exceedes the MTOW, the difference will be highlighted in red text. If the current weight is less than the 
MTOW, the difference will be highlighted in green text.

14)	 Touch Email W & B to send the current W&B as an email associated with the active account.
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Aircraft Info

Touch to Enter/Edit

Touch to Enter/Edit

Touch to Select

Touch to Enter/Edit

Calculated Data
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FltPlan GO - Tools - Weight & Balance - Chart - Calculated - CJ1

Touch to Calculate

Touch to Send 
W&B via Email

C.G. Taxi

Max Ramp WeightMax Takeoff Weight

C.G. Takeoff

C.G. Fuel Burn

C.G. Landing
Max Zero 

Fuel Weight

Max Landing Weight

C.G. Landing

Taxi Data

Takeoff Data

Landing Data

FltPlan GO - Tools - Weight & Balance - Chart Legend
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FltPlan GO - Tools - Weight & Balance - Plane Image Legend

CONTACTS

From the Tools Tab, touch  to view telephone numbers for Airlines, Hotels, and Rental Cars. The User can touch  in 
the upper right corner to refresh data. Select as desired, then touch the 'Back' button to exit. 

FltPlan GO - Tools - Contacts

Touch to View

Touch to Refresh Data
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CALCULATORS
Within the Tools Tab, the second group of icons are all various calculators, such as:

	� Numeric

	� Temperature Conversion

	� ISA Temperature

	� Density Altitude

	� Fuel Conversions

	� Equal Time Point

	� Runway Wind Calculator

	� Airport Winds

NUMERIC

Touch  to display a generic, numeric calculator. Adjust as desired, then touch Back to exit. 

FAHRENHEIT/CELCIUS TEMPERATURE CONVERSION

Touch  to display a Fahrenheit to Celcius (or vice versa) Converter. Enter a temperature in either the F° or C° text box, 
and the conversion will autopopulate. 

FltPlan GO - Tools - Calculators - Temp Conversion

Enter Info

Touch to Delete
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ISA TEMPERATURE CONVERSION

Touch  to view the ISA Temperature Calculator, where the User can input a Pressure Altitude (ft or meters), and a 
Temperature (C°), to calculate the ISA Temperature. 

Calculating ISA Temperature:

1)	 Touch Tools > .

2)	 Enter a Pressure Altitude (ft. or meters).

3)	 Enter a Temperature (C°).

4)	 Touch Calculate. The autogenerated data is listed below. 

5)	 Touch  'X' to remove data.

6)	 Touch the 'Back' button to exit.

FltPlan GO - Tools - Calculators - ISA Temp Conversion

Enter Info

Touch to Adjust

Touch to 
Calculate

Touch to 
Clear Data
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DENSITY ALTITUDE

Touch  to view the Density Altitude Calculator, where User can select an airport to view the Elevation, Altimeter 
Setting, Pressure Altitude, Outside Air Temperature, and Density Altitude. 

Calculating Density Altitude:

1)	 Touch Tools >  . 

2)	 Touch the Find Nearest Airport button to automatically load the airport nearest the device location.

3)	 Touch the View WX button to view the latest weather information for the selected airport via FltPlan.com.

4)	 Enter the Current Altimeter Setting (inHG or mbar).

5)	 Enter the Outside Temperature (C° or F°).

6)	 The Pressure Altitude and Density Altitude will be calculated and displayed (ft. or meters).

7)	 Touch  to refresh the weather data.

8)	 Touch Calculator or the 'Back' button to return to the Density Altitude Calculator.

FltPlan GO - Tools - Calculators - Density Altitude Conversion

Touch to View 
Weather via 
FltPlan.com

Touch to Adjust

Touch to Load 
Nearest Airport

Enter Info

Autopopulated 
Data

Enter Info

Autopopulated 
Data

Touch to Load 
29.92 inHg
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FltPlan GO - Tools - Calculators - Density Altitude Conversion - Get WX

Temp (C°) & 
Altimeter

Touch to Return 
to Calculator
Touch to Refresh 
Data
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FUEL CONVERSION

Touch  to view the Fuel Conversion page, where the User can select the fuel Type (AVGAS or Jet A), or enter a Custom 
Fuel Type, then enter the Fuel Amount, Fuel Price, Fuel Required, and Fuel Onboard. Once all the information has been 
entered, the fuel conversion and Total Price calculation can be viewed in either Pounds or Gallons. 

Converting Fuel:

1)	 Touch Tools > .

2)	 Select AVGAS, Jet A, or Custom.

3)	 Enter the amount of Fuel on Board.

4)	 Enter the amount of Fuel Required. 

5)	 Touch the Calculate button to display the Fuel Needed. Toggle the Pounds / Gallons buttons as necessary. 

6)	 Enter amount of Fuel Needed in the appropriate category, (e.g. Pounds, Gallons, Kilograms, Litres). The other fuel categories will 
autofill with the proper conversion.

7)	 Touch the Gallon, GAL button (the button will display the most recent selection) to select the unit of measurement, (e.g. gal, 
lit, lb, kg, IG).

8)	 Enter the fuel price per unit sold (e.g. $10.50). The Total price will be calculated and displayed (U.S. $). 

9)	 Touch the 'Back' button to exti.
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FltPlan GO - Tools - Calculators - Fuel Conversion

Enter Info

Touch to 
Calculate Fuel 
Needed

Touch To Select

Touch to Delete

Touch To Select
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EQUAL TIME POINT

Touch  to view the Equal Time Point conversion page, where the User can enter the Route to Destination, Ground 
Speed Forward and  Ground Speed Back.

Calculating Equal Time Point:

1)	 Touch Tools > .

2)	 Enter the Route to Destination

Or	 Toggle the Use Present Position to Destination button 'On'.

3)	 Enter the Ground Speed Forward (knots).

Or	 Toggle the Use Actual Ground Speed button 'On'.

4)	 Enter the Ground Speed Back (knots). 

Or	 Toggle the Use Actual Ground Speed button 'On'.

5)	 Touch the Calculate button. The Equal Time Point will be displayed in Nautical Miles.

6)	 Touch Clear to remove all data.

7)	 Touch the 'Back' button to exit. 

FltPlan GO - Tools - Calculators -Equal Time Point

Touch to Toggle 
On/Off

Touch to Clear 
All Data

Touch to 
Calculate

Touch to 
Enter Info

Calculated 
Data
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RUNWAY WINDS

Touch  to view the Runway Winds Calculator, where User can enter the Runway Number, Wind Direction, Wind 
Velocity, Wind Gusts, Ref Speed, and set wind limitation Preferences. 

Entering/Adjusting Wind Calculator Preferences:

1)	 Touch Tools >  > Preferences.

2)	 Touch the desired text box and enter wind velocity (knots) and Target Speed preferences/limitations.

3)	 Touch Steady State Wind or Head Wind Comp to enter calculation(s). 

4)	 Touch '-' or '+' to adjust percentage calculation(s) for Steady State Wind or Head Wind Comp, as desired. 

5)	 Touch anywhere outside the Preferences dialogue box to exit, or touch the Close button to exit. 

FltPlan Go - Tools - Calculators - Runway Wind Calculator - Preferences Menu

Touch to Enter Info

Touch to View/Adjust

Touch -/+ to Adjust

Touch to Enter Info
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Entering/Adjusting Wind Information:

1)	 Touch Tools > .

2)	 Adjust the Slider to the desired Runway Number. Touch '-' or '+' to make small adjustments.

3)	 Adjust the Slider to the desired number for Wind From (Radial Measure in Degrees, e.g. 090 = From the East, 180 = From the 
South, etc.). Touch '-' or '+' to make small adjustments.

4)	 Adjust the Slider to the desired number for Wind Speed (Knots). Touch '-' or '+' to make small adjustments.

5)	 If necessary, adjust the Slider to the desired number for Gusting to (Knots). Touch '-' or '+' to make small adjustments.

6)	 If necessary, touch within the 'Ref Speed' box to enter the desired number (Knots). Touch '-' or '+' to make small adjustments. 
The Target Speed will autocalculate as data is entered/adjusted.

7)	 Touch the 'Back' button to exit and return to the previous page.

FltPlan Go - Tools - Caclulator - Runway Wind Calculator

Touch to 
View/Edit

Crosswind 
ComponentHeadwind 

Component

Current 
Runway

Touch -/+ to Adjust
Slide to Adjust
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AIRPORT WINDS

Touch  and enter the Airport ID (ICAO), e.g. KOJC. The User will now be directed to the Runway Wind Calculator, as 
previously mentioned, but this time the available runways for the selected airport will be listed. 

Entering/Adjusting Wind Information:

1)	 Touch Tools > .

2)	 Enter the Airport ID (ICAO) and select desired runway.

3)	 Adjust the Slider to the desired number for Wind From (Radial Measure in Degrees, e.g. 090 = From the East, 180 = From the 
South, etc.). Touch '-' or '+' to make small adjustments.

4)	 Adjust the Slider to the desired number for Wind Speed (Knots). Touch '-' or '+' to make small adjustments.

5)	 If necessary, adjust the Slider to the desired number for Wind Gusts (Knots). Touch '-' or '+' to make small adjustments.

6)	 If necessary, touch within the 'Ref Speed' box to enter the desired number (Knots). Touch '-' or '+' to make small adjustments. 
The Target Speed will autocalculate as data is entered/adjusted.

7)	 Touch the 'Back' button to exit and return to the previous page.

FltPlan Go - Tools - Calculators - Airport Winds Calculator

Touch to 
View/Edit 
Preferences

Touch to Change 
Airport

Selected Runway  
Used for Calculation

Crosswind 
ComponentHeadwind 

Component

Unfavorable 
Runway(s)

Touch -/+ to Adjust

Slide to Adjust

Relative Wind 
& Runway

Caution & 
Limit Exceeded 
Annunciator(s)

Touch -/+ to Adjust
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SCRATCH PAD 
The Scratch Pad icon is eleventh on the Home Menu, with seven buttons located in the Header Menu: Clear, Undo, Background, 

My Doodles, Save, Precise, and Color.

MY DOODLES

Creating a Doodle:

1)	 Touch the My Doodles button (the most recent selection will be displayed as the title, e.g. KDAL.PDF).

2)	 Touch New Noodle.

3)	 Select the desired Doodle Type, Draw, Text, or Approach Plate.

Or	 Touch Cancel to exit.

4)	 Enter the Title of the New Doodle, then touch Add.

5)	 Adjust as desired, then touch Save.

6)	 Touch the My Doodles button, then select the recently created Doodle to view/adjust.

FltPlan Go - Scratch Pad - Select Doodle Type

Touch to View

ANNOTATING A DOODLE

Touch Background to search for the desired Airport, then select a chart to annotate. Touch Color to select the color of 
the penstroke, e.g. Black, Red, Blue, Green, Yellow, etc. Touch Size to select the size of the penstroke. Touch the Undo arrow 
to remove the most recent annotation. Touch the Paintbrush to annotate. Touch the Pencil to draw freehand. Touch the 
'Square' icon to create a square shaped annotation. Touch the 'Circle' icon to create a circular annotation. Touch the 'Save' 
icon to save the most recent annotation(s). Touch Done to exit the annotate process.

FltPlan Go - Scratch Pad - Banner Menu

Select Penstroke Touch to Display My Doodles

Select Color Select Chart

FltPlan Go - ScratchPad - Approach Plate - Annotate Icons

Undo

Save Create Square Paintbrush

DrawCreate Circle
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Touch to View

Touch to View My Doodles
Touch to Adjust

FltPlan Go - Scratch Pad - Approach Plate - Annotate - STAR
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Annotating a Doodle:

1)	 Touch the My Doodles button (the most recent selection will be displayed as the title, e.g. KDAL.PDF).

2)	 Select the desired Doodle from the list.

Or	 Touch Background to select an new airport and chart.

3)	 Touch Size to adjust the penstroke size.

4)	 Touch Color to adjust the penstroke color.

5)	 Touch the 'Square' icon to create a square annotation.

6)	 Touch the 'Circle' icon to create a circular annotation.

7)	 Touch Undo to remove the most recent annotation.

8)	 Touch Save to save annotations. 

Viewing My Doodles:

1)	 Touch the My Doodles button (the most recent selection will be displayed as the title, e.g. AFD).

2)	 Select the desired Doodle from the list.

3)	 Annotate as desired, then touch Save. The Doodle will now be saved to the My Doodles list.

Deleting My Doodles:

1)	 From the My Doodles menu, touch  across from the Doodle Title.

2)	 Touch Close to exit.

FltPlan GO - Scratch Pad - My Doodles Menu

Touch to Delete

Touch to Create 

Touch to View
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DOWNLOADS 
The Downloads icon is twelfth on the Home Menu, and allows the User to download and update various charts for offline use. 

Available charts include Maps, Procedures, Documents, and AF/D. The Banner Menu consists of six buttons, Failed Downloads, 
Update All, Cancel All, Delete, Save, and Refresh.

FltPlan Go - Downloads - Banner Menu

Touch to View

Touch to Update All Downloads

DeleteTouch to Cancel All Downloads

Save

Refresh

FAILED DOWNLOADS
Touch the Failed Downloads button to view all unsuccessful downloads. Select the desired download to retry, or touch Retry 

All Failed Downloads (if applicable).

FltPlan GO - Downloads - Failed Downloads Menu

Touch to Exit Touch to Retry All Failed Downloads

UPDATE ALL
Touch the Update All button in the Banner Menu to download all available downloads for Maps, Procedures, Documents, 

AF/D, and Misc.The User will also have the option to select Update Expired Maps, Update Expired Procedures, Download 
Future Procedures, and Update Expired AFDS.

FltPlan GO - Downloads - Update All Menu
Touch to Exit

Current Selection

Touch to Select
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CANCEL ALL
Touch the Cancel All button in the Banner Menu to stop all active or queued downloads.

DELETE
Deleting Files:

1)	 Touch  to display a window entitled 'Delete Files'. 

2)	 Touch the desired section to delete files, e.g. Maps.

FltPlan GO - Downloads - Delete Menu

Touch to View

Touch to Delete All 
Expired Files

Touch to Exit

3)	 Touch  next to the desired file to Delete.

Or	 Touch Delete All Expired Files. 

4)	 Touch Back to return to the 'Delete Files' window. 

Or	 Touch Close to exit.  

FltPlan GO - Downloads - Delete - Maps - Jet High

Touch to Delete

Touch to Exit

Touch to Delete All Expired Files Touch View Previous Menu
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MAPS
The Maps section within Downloads allows the User to view, download, and delete a variety of charts, such as:

	� Jet High (USA, Canada, and Caribbean)

	� Victor Low (USA, Canada, and Caribbean) 

	� IFR Area Charts (USA and Canada)

	� Sectionals (USA and Canada)

	� Terminal Aera Charts (USA and Canada)

	� Helicopter Charts (KDCA, KBOS, KORD, KDAL, KDET, Gulf, KHOU, KLAX, and New York)

	� Reference Maps (North America and World)

	� Layers (Airports, State Borders, Civil Air Patrol Grid, and Runway Centerlines)

Downloading Maps:

1)	 From the Downloads Page, touch Maps > Select. 

Or	 From the Downloads Page, touch Maps > Update All.

2)	 Touch the desired chart on the map to display the Select Map menu.

3)	 Select the desired chart from the Select Map menu to start the download.  

Or	 Touch Download All to download all available charts for the current selection, e.g. Victor Low - USA. The chart queue will scroll 
across the top of the Downloads screen as the selected items are downloaded. 

FltPlan GO - Downloads - Maps
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FltPlan Go - Downloads - Maps - All CAR

Touch to Download

Touch to 
Download All

Successfully 
Downloaded

Touch to View 
Previous Menu

Current Selection

Chart Name, File 
Size, & Download 

Progress
Touch to Cancel 

Touch to View

Chart Downloading/
Queued

FltPlan Go - Downloads - Maps - Select CAR

Touch to Download

CHART STATUS

Within Maps section of the Downloads Page, the Chart Status is located next to the Select button. When there is an update 
available, touch the dark blue Update button to start downloading the appropriate data. When the data has downloaded 
successfully, the button will display Current and change to the color green. When there are expired charts, the Update button 
will be red. 

	
NOTE: The Chart Status only represents maps that are downloaded.
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FltPlan GO - Downloads - Maps - Updates Needed

Helicopter Charts 
Queued

Touch to View/
Select Chart(s)

Nothing 
Downloaded

Touch to View

Touch to Refresh

Touch to 
Cancel All

Touch to 
Update All

Expired Chart(s)

Current & 
Successfully 
Downloaded

Touch to View
Chart Name, File 

Size, & Download 
Progress

Touch to SaveTouch to Delete

Touch to Cancel

Current Selection
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Downloading Helicopter Charts:

1)	 From the Downloads Page, touch Maps. Scroll down to the Helicopter Charts section.

2)	 Touch the desired chart ID (Three Letter Airport ID's are listed except for the Gult Coast and the New York City area) to begin 
downloading. Once complete, the chart ID will be green. 

Downloading Reference Maps:

1)	 From the Downloads Page, touch Maps. Scroll down to the Reference Maps section.

2)	 Touch the desired map, North America (NA) or World Map (WM) to begin downloading.

Downloading Layers:

1)	 From the Downloads Page, touch Maps. Scroll down to the Layers section.

2)	 Touch the desired layer, Airports Layer (ARP), State Boarders (STB) , CAP Grid, or Runway Centerlines (CEN) to begin 
downloading.

PROCEDURES
The Procedures section within Downloads allows the user to view the download/currency status for the U.S. (Current and 

Future), Canada, and the Caribbean (Current and Future). Touch the desired icon to download the applicable chart(s). 

Touch the Update All button in the Banner Menu to download all available downloads for Maps, Procedures, Documents, 
AF/D, and Misc.The User will also have the option to select Update Expired Maps, Update Expired Procedures, Download 
Future Procedures, and Update Expired AFDS.

FltPlan GO - Downloads - Update All Menu
Touch to Exit

Current Selection

Touch to Select

FltPlan GO - Downloads - Legend
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Touch to View

Touch to Refresh

Touch to 
Cancel All

Touch to 
Update All

Touch to View

Chart Name, File 
Size, & Download 

Progress

Touch to SaveTouch to Delete

Touch to Cancel

Current Selection

FltPlan GO - Downloads - Procedures
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DOCUMENTS
The Documents section within Downloads allows the user to view the download/currency status of various aviation 

documents. Imported documents will appear at the top of the list. Touch the desired document title to download. Touch and 
hold the document title to Delete.

Touch the Update All button in the Banner Menu to download all available downloads for Maps, Procedures, Documents, 
AF/D, and Misc.The User will also have the option to select Update Expired Maps, Update Expired Procedures, Download 
Future Procedures, and Update Expired AFDS.

FltPlan GO - Downloads - Update All Menu
Touch to Exit

Current Selection

Touch to Select

FltPlan GO - Downloads - Documents

Current Selection

Scroll Up/Down 
to View

Touch to Cancel
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A/FD
The A/FD section within Downloads allows the user to view the download/currency status of various AF/D's throughout the 

U.S. as well as the Canadian Flight Supplement. 

Touch the Update All button in the Banner Menu to download all available downloads for Maps, Procedures, Documents, 
AF/D, and Misc.The User will also have the option to select Update Expired Maps, Update Expired Procedures, Download 
Future Procedures, and Update Expired AFDS.

FltPlan GO - Downloads - Update All Menu
Touch to Exit

Current Selection

Touch to Select

FltPlan GO - Downloads - A/FD

Current Selection

Touch to Cancel
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MISCELLANEOUS
The Misc. section within Downloads allows the user to view the download/currency status of the Airports Database, FBO 

Icons, and Airport Diagrams. Touch the desired button to start downloading the relevant data. 

FltPlan GO - Downloads - Miscellaneous

Current Selection

Touch to Cancel

Successfully 
Downloaded & 

Current

Downloading or 
Queued
Expired
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SETTINGS 
The thirteenth and final icon in the Main Menu is Settings. Here, the User can adjust how the device interacts with the FltPlan 

Go program, such as:

	� Toggle Sleep Mode

	� Enable Night Mode

	� Toggle Background GPS

	� Minimum Runway Length

	� Email Support

	� Messages From FltPlan

	� Privacy Policy

	� Help Guide & Tutorial

	� Open Source Licenses

	� App Build Version

	
NOTE: If the device is set to 'Auto Brightness', the User will not be able to Enable Night Mode. Please adjust the device settings 
accordingly to allow the FltPlan Go program to 'Enable Night Mode'. 

TOGGLE SLEEP MODE
When toggled On, the device will go into sleep mode. When toggled Off, the device will not go into sleep mode while FltPlan 

Go is open

ENABLE NIGHT MODE
When toggled On, the screen brightness will automatically dim to a low setting favorable for night flight and/or batery 

conservation.

TOGGLE BACKGROUND GPS
When toggled On, FltPlan Go will continue to use GPS while the app is closed. Enabling this feature is important when using 

the Breadcrumbs feature

MINIMUM RUNWAY LENGTH (FT)
Touch to view a pop-up window listing runways distances in feet from 1,000 to 10,000. Select the desired minimum runway 

length. Once a selection has been made, FltPlan Go will only display airports with the set runway length in the Airports Page

RECEIVE NOTIFICATIONS
When toggled On, flight plan and NavLog updates will be displayed within FltPlan Go. When toggled Off, the updates will 

still be received, but void of a notification.

EMAIL SUPPORT
Touch Email Support to draft an email to Garmin Support via tech@fltplan.com. The device information, software version, 

FltPlan Build Number, and Short Build Number will autopopulate in the signature block for reference/troubleshooting/
diagnostics.

MESSAGES FROM FLTPLAN.COM
Touch to view a pop-up window listing any notes from FltPlan.com, e.g. Compatability testing status for Android updates.
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PRIVACY POLICY
Touch to view Garmin's Privacy Policy via web browser.

HELP GUIDE & TUTORIAL
Touch Help Guide & Tutorial at the top of the Settings Menu to view the FltPlan Go manual in a browser window.

OPEN SOURCE LICENSES
Touch to view textural information regarding open source licenses.

APP VERSION
This tab informs the user which version of the app is currently installed, in addition to the build number. This information 

may be helpful in troubleshooting issues.

FltPlan Go - Settings

Touch to Toggle 'On/Off'

Touch to View/Adjust

Touch to Exit

Touch to Compose Email

Touch to View
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A
ADS-B  25, 26
Aircraft  28
Airport Diagram  16, 17, 22
Airport of Entry  20
Annotate  17
Approach  27
AWOS  85

B
Breadcrumbs  34

C
Calculator  11, 131, 132, 137, 139
Canada  9
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Customs  27, 49

D
Device  4
Documents  4
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Information  4, 10, 14, 19, 20, 22, 24, 25, 26, 27, 28, 29, 38, 83, 85

J
Jet  20, 32, 99

K
KML  34

M
MOS  25

N
NOTAMs  7, 26

P
Print  100
Procedure  57

R
Runway Wind Calculator  11, 139

S
ScratchPad  35
SIDs  22
Split Screen  35, 57
STARs  22

T
Tailwind  11
TFRs  42
Tool  40

V
Visibility  25

W
Waypoint  63
Weight & Balance  4, 38

X
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